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WindSim Desktop 12 

About WindSim 

Micrositing 

WindSim is a modern Wind Farm Design Tool (WFDT). WindSim is used to optimize the 

wind farm energy production while at the same time keeping the turbine loads within 

acceptable limits. This is achieved by calculating numerical wind fields over a digitalized 

terrain. In the wind energy sector this is called micrositing. 

 

By coupling the numerically calculated wind speeds and wind directions against available 

site-specific climate conditions the optimal position for each turbine can be found. Climate 

conditions are most frequently given by on-site measurements but could alternatively be 

derived from meteorological models. WindSim can interface with both of these types of 

datasets. 

 

The loads on a wind turbine are influenced by wind field characteristics such as; wind shear, 

inflow angle, and turbulence. Since the wind field modelling is 3D all of these characteristics 

are calculated and checked to be within acceptable limits for a given turbine type. 

 

The optimization of the energy production and the minimization of the loads could be 

conflicting processes. The location yielding maximum energy production for a wind turbine 

could also yield too high loads, and often a compromise must be found: a location with the 

highest possible energy production still with acceptable loads. Micrositing is an iterative 

process where various turbine locations and types must be inspected. 

Modular Approach 

WindSim uses a modular approach with six modules to complete the steps within micrositing. 
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Figure 1 - WindSim is a modular based Wind Farm Design Tool (WFDT) 

A full micrositing will require execution of all six modules. The modules must be executed in 

the right order as there are dependencies between the modules. However, depending on the 

purpose of the project, it is not always necessary to run all the modules. 

WindSim Modules 

• Terrain 

Establish the numerical model based on height and roughness data. 

• Wind Fields 

Calculation of the numerical wind fields. 

• Objects 

Place and process wind turbines and climatology data. 

• Results 

Analyse the numerical wind fields. 

• Wind Resources 

Couple the numerical wind fields with climatology data by statistical means to provide 

the wind resource map. 

• Energy 

Couple the numerical wind fields with climatology data by statistical means to provide 

the Annual Energy Production (AEP); including wake losses. Determine the wind 

characteristics used for turbine loading. 

 

In addition to the modules there are stand-alone Tools for data preparation and data post-

processing. In particular, Tools are used for the import and preparation of terrain and 

climatology data. WindSim also works with Add-on Modules including the Remote Sensing 

Correction Tool (RSCT) and Park Optimizer. 
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About the Technology 

Computational Fluid Dynamics (CFD) is used to 

perform the wind field simulations in WindSim. CFD 

is a numerical method for solving the fundamental 

equations of fluid flow. CFD has become a very 

useful method within many industries. Accurate flow 

simulations are required within the automotive 

industry, oil and gas, and of course within the 

aerospace industry. In these industries CFD has 

become the standard method for flow calculations. 

 

The fundamental behaviour of fluid flow is described 

by the Navier-Stokes equations. The Navier-Stokes 

equations are non-linear partial differential equations 

known to be unstable and difficult to solve. Therefore 

simplified methods, where the troublesome non-

linear terms have been linearized have become 

popular within the wind energy sector. However, 

the severe penalty is the reduced accuracy in the 

results. The differences between the traditional so 

called linear method and the CFD method could 

be illustrated by looking at speed-up over a ridge. 

The speed-up increases with increasing inclination 

angles until the flow separates, as seen in the 

upper part of Figure 2. 

 

This behaviour is captured by a CFD method. 

Even for smaller inclination angles, when the flow 

does not separate there is a significant difference in predicted speed-up between the linear 

and the CFD methods. 

 

For an inclination angle above 20 degrees (Case C) the flow separates. The recirculation 

acts as an extension of the terrain, the ridge becomes more like a plateau and the speed-up 

is reduced. 

Figure 2 - Upstream speed-up, (Speed hill 

top/speed inlet). Average inclination angle 

(degrees) A) 5.7 B) 11.3 C) 21.8 - Linear 

model (light grey) CFD model (dark grey). 
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The Navier-Stokes equation is time averaged introducing terms for the speed fluctuations. A 

turbulence model is required to close the equation set of the so-called Reynolds Averaged 

Navier-Stokes equation (RANS). The RANS equations are discretized in a computational 

domain and integrated with a finite-volume procedure. 

 

There are various solvers and solver strategies implemented in the software. Turbulence is 

taken into account using various types of two equation models like the k- model. 

 

We invite you to learn more about the Bolund Experiment. The Bolund experiment is a field 

campaign that provides datasets for validating numerical models of flow in complex terrain 

and was the basis for a unique blind test comparison of flow models. The CFD methods—

including WindSim—showed the lowest errors among the various methods used. Find out 

more about The Bolund Experiment (windsim.com). 

WindSim Evaluation versus WindSim Commercial 

WindSim Evaluation (EV) contains all the features of the commercial version but is intended 

for evaluation use. WindSim EV can be downloaded for free. The only restriction of WindSim 

EV is the maximum number of cells used to discretize the computational domain. The total 

maximum numbers of cells are 50 000, and there are 10 layers of cells vertically. The limit on 

the number of cells; as will be shown in the following paragraphs, have two effects: 

 

• It smoothes the given height and roughness data 

• It introduces significant discretization errors 

 

The results obtained with WindSim EV are therefore not intended for commercial work. 

However, the user will be able to explore all the features of the software with the evaluation 

version, and also appreciate the power of the commercial version. 

 

 

Terrain  

The first step in the set-up of flow field simulations is the generation of a 3D model of the 

area of interest. This is done in the Terrain module. But first the basis for the 3D model must 

be available, which is a 2D dataset with elevation and roughness data in .gws format. 

https://windsim.com/library/the-bolund-experiment/
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Digital terrain conversion 

When starting a new project you will be asked for a grid.gws file containing the elevation and 

roughness data of the terrain in a regular grid. The grid.gws file can be viewed by using 

the Tools → View terrain model menu item. If no .gws file is specified a demo file is 

automatically copied into the dtm (digital terrain model) projects folder. 

Conversion from other formats is performed by clicking the Tools → Convert terrain 

model menu item. If you need extensions in order to perform the conversion of your specific 

data, see examples of supported third party formats. Alternatively, you can convert your 

terrain model directly to the .gws format by using your own tools, see: terrain field data. 

Properties 

 1. Terrain extension 

Coordinate system 

The coordinates in the grid.gws file can refer to any global orthogonal system. This 

coordinate system is called system 3 in the grid.gws file. After generation of the 3D model, a 

local coordinate system (referred to as system 1) is introduced in the lower left-hand corner. 

Later in the Objects module the placements of objects can be referenced to by either the 

global or local coordinate system. 

 

Figure 3. Sketch of the defined coordinate systems. 

https://windsim.com/library/Module%20Overview/Terrain_third_party_format.html
https://windsim.com/library/Module%20Overview/Terrain_field_data_format.html
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X-range and Y-range 

Extensions in the east-west direction and in the south-north direction. The specified 

coordinates may be increased to fit the nearest node in the grid.gws file, as interpolation of 

the underlying data is avoided. Default values are the minimum and maximum extensions in 

the grid.gws file [m]. 

Projection 

The parameters that are shown under Projection identify the global coordinate system as 

given in the grid.gws file distinctively. Given is the Projection system, the Datum and 

the Zone. From that information WindSim calculates the EPSG code and stores that 

information in the grid.gws file for later use in WindPRO and Google export. 

 2. Roughness 

Roughness height 

By default, variable roughness heights are read from the grid.gws file. Alternatively, a 

constant roughness height can be imposed in the model by specifying a non-zero value for 

the roughness height. 

The roughness height is defined in the log-law  

U

Uτ
=

1

κ
ln(z/z0), 

where 

𝑈 - wind velocity, 

𝑈τ - friction velocity √
𝜏0

𝜌
  , 

τ0 - shear stress, 

ρ  - air density, 

κ - von Karmans constant (κ = 0.435), 

𝑧 - coordinate in vertical direction, 

𝑧0 - Roughness height. 

3. Numerical model 

With the Automatic gridding option set to False the grid on the ground level specified by 

the Refinement type as well as the grid in vertical direction can be adjusted by the user. 

Vertical Grid 

The grid in vertical direction is determined by the following parameters being relevant for all 

choices of Refinement type except the specification of the whole grid by loading a refinement 

file. 

http://windsim.com/
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Vertical Expansion 

Enable the choice to have the type of vertical expansion, Arithmetical or Geometrical 

expansion. 

Height above terrain 

The height above the terrain is defined as the vertical distance between the highest elevation 

point in the 3D model and the upper boundary. In order to set a proper value for this height, 

two seemingly contradictory requirements must be balanced. On the one hand, the 

distribution of nodes in the vertical direction should be as dense as possible for obtaining 

accurate numerical solutions, near the ground (see also Height distribution 

factor and Number of cells in Z direction). This requirement implies that the upper boundary 

should be placed as near the ground as possible. Yet, on the other hand, if the upper 

boundary is too close to the ground this would impose a blocking effect when the flow field 

passes over mountains. 

As a rule of thumb the fraction between the minimum open area 𝑧𝑚𝑖𝑛 and the maximum open 

area 𝑧𝑚𝑎𝑥 between the ground and the upper boundary, calculated as the model is traversed 

in west-east and south-north direction, should be larger than 95%. By setting Height above 

terrain to Automatic a height will be calculated satisfying the relation 
z𝑚𝑖𝑛

𝑧𝑚𝑎𝑥
> 0. 95. In some 

cases the automatic procedure might fail. The procedure will not capture the case with a 

ridge along the diagonal of the model, as the traverse in west-east and south-north direction 

will not detect significant changes in open area. But blocking might occur when the incoming 

flow is perpendicular to the ridge. Likewise for an isolated island or mountain the height of 

the upper boundary will be reduced (as soon as the 2D modelled area) as the total modelled 

area is increased, which could lead to blocking in extreme cases. Alternatively, a specific 

height could be given. 

Height distribution factor 

The cell distribution in the vertical direction follows an arithmetic or geometrical sequence. If 

arithmetical the height distribution factor gives the fraction between the cell at the ground and 

the cell at the upper boundary. If geometrical the height distribution factor defines the 

proportion of width increase of each cell height compared to the lower one. The vertical cell 

distribution could be inspected under the 3D model section in the terrain report. Default value 

is 0.1 [-] if arithmetical expansion, 0.3 [-] if geometrical. 

Number of cells in Z direction 

Number of cells in the vertical direction. Default value is 20 [-]. 

Low-level uniform cells 

Defining the low-level uniform cells enable to set the first vertical cells to have uniform grid 

spacing, the above cells follow the expansion defined by previous options. Uniform vertical 

cells number n and height h define the level properties and resolution. The vertical grid area 

of height h is discretized by n cells. The levels above the uniform area are expanding, 
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depending on the height of the models and the expansions settings. All cells' heights above 

the uniform area are set to have the same cell height as in the low-level area or higher. 

Compression and expansion in the vertical grid are not allowed as it could produce 

unrealistic solver results. 

Refinement type 

By default no refinement of the grid in the ground plane is performed. By setting 

the Automatic gridding option to False additionally a refinement area can be specified, then a 

denser distribution of nodes will be allocated within the refined area. 

Refinement area, X-range and Y-range 

Extensions in the east-west direction and in the south-north direction of the refinement area. 

By default the area is given in the centre with an extension equal to 1/3 of the total area 

extension. The cell distribution is uniform within the refined area with an increasing cell size 

towards the borders. The data used for setting up the refinement area is stored in the current 

project under the folder dtm in the file simple_refinement.bws. 

 

Horizontal gridding 

• Maximum number of cells: 

The 3D model will consist of 𝑛𝑥 ⋅ 𝑛𝑦 ⋅ 𝑛𝑧   cells. The number of cells in z direction is set 

in Number of cells in z direction, default value is 20 [-]. The number of cells 

in 𝑥 and 𝑦 direction is set according 𝑛𝑥 ⋅ 𝑛𝑦 ⋅ 𝑛𝑧   maximum number of cells, by 

skipping nodes in the field data set. Whenever a regular model is created then the 

extension of the model might be slightly modified as no interpolation of the underlying 

field data is performed, see figure 4. If Refinement is used, then an interpolation is 

performed anyway and the number of cells in the model will be approximately 

adjusted to the specified Maximum number of cells. 
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Figure 4. Field data extraction fitting the set maximum number of cells. In the upper case the 

maximum number of cells has been given a large value and the finest resolution possible for a regular 

grid model was created. In the middle case the maximum number of cells is smaller and the extraction 

procedure skipped every second node in the field data set. In the lower case refinement is set and the 

extraction procedure interpolates the field data set giving a model with approximately the maximum 

number of cells specified by the user. 

 

The obtained number of cells and corresponding grid resolution is found under the 3D 

model section in the terrain report. The computing time required is exponentially 

proportional to the number of cells. Consider splitting a large model into several 

smaller models using the nesting technique as described under the Wind 

Fields module or use the refinement technique in order to handle large terrain areas. 

• Horizontal resolution: 

In the case of refinement described with a refinement area the computational grid can 

also be constructed by assigning the Horizontal resolution in the refined area, 

combined with a law for the expansion of the grid in the zones surrounding the refined 

area. 

• Ratio additive length to resolution 
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The expansion of the grid is defined by the ratio of the additive length 𝛿 to the 

horizontal resolution set in the inner refined area. 

 

Figure 5. Sketch of the expansion law applied to the horizontal grid. 

 

Expansion law, arithmetic sequence, for a zone on the right side of uniform grid. A 

fixed length 𝛿 is added to the length of a general cell 𝑘 − 1 to obtain the length of the 

successive cell k. The additive length 𝛿 is calculated from the Ratio additive length to 

resolution  𝛿/ Δ𝑥, where  

𝐿 = ∑ 𝑙𝑘

7

𝑘=1

 

with 𝑙𝑘 = 𝑙𝑘−1  +  𝛿 and 𝑙1 = Δ𝑥 

Refinement/blocking file 

Files with the extension .bws are blocking or refinement files and can be loaded 

separately, syntax and examples. 

Actuator disc 

The actuator disc is the concept to model a turbine as a disc that is providing forces to the air 

flow which are equivalent to the actual forces exchanged by a real wind turbine and the flow. 

With WindSim it is possible to generate a grid modelling the wind turbines as a set of 

actuator discs. In order to design a computational grid with a set of actuator discs an object 

file (.ows) has to be defined which contains the layout of the wind farm. Additionally, the 

number of spacings can be specified, referring to the number of spacings used to discretise 

the rotor diameter. 

https://windsim.com/library/Module%20Overview/Terrain_bws.html
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• Object file: 

An actuator disc will be designed over each wind turbine. The layout of the wind farm 

is therefore loaded from an object file (.ows). The same layout has to be loaded in 

the Objects module of WindSim where it can also be produced as an output file. Thus 

the standard procedure in order to include the actuator disc model can be as follows: 

first run the Terrain module and neglect the actuator disc option therein, then jump to 

the Objects module, place all turbines as explained in the corresponding "description 

pages" and export your windfarm layout by using the Export → Export objects 

(.ows) dropdown option, finally return to the Terrain module and import the Object file 

here with the actuator disc enabled. The same layout has to be loaded in 

the Objects module of WindSim, to reach the goal is useful to load the same object 

file in the Objects module. In order to run WindSim with the actuator disc option 

enabled, the module to be run after the Terrain module has to be the Objects (having 

the same layout included in the .ows of the Actuator disc), and, after the Objects, the 

Wind Fields. 

• Number of spacings: 

The computational grid is designed having as reference length a subdivision of the 

rotor diameter which will be the minimum grid resolution, both horizontal and vertical, 

in the area of the wind farm. The grid will expand gradually from the wind farm region 

to the borders and top of the domain. The default value is 16 that has proven to bring 

the discretization errors to an acceptable low value, therefore it is suggested to keep 

the number of spacings to 16 or higher. 

 

 4. Smoothing 

Smoothing type 

Various smoothing types can be used to smoothen the terrain. In some cases a wind field 

simulation fails to give a physical solution, the solution procedure diverges. Smoothing of the 

terrain is a technique for battling divergence. 

Divergence could be caused by abrupt changes in the inclination between adjacent cells. 

Areas with abrupt changes in the inclination would be found in narrow valleys or at sharp 

mountain peaks. Typically, these areas would not be of interest for placing wind turbines, and 

as such a slight modification of the terrain could be accepted. 

Terrain smoothing should be used with care, as excessive use will significantly change the 

heights of the terrain. Both the second order derivatives, which is a measure of the 

smoothness, and the changes between the original heights and the heights after smoothing 

are given in the report. Inspect these results, and make sure that areas of interest have not 

http://windsim.com/
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been significantly changed. To smooth areas that are not of interest will speed-up the wind 

field simulations. 

No smoothing 

By default no smoothing is applied. 

Bi-linear smoothing 

Smoothens the terrain by marching along x and y directions sequentially. Bi-linear 

smoothing is a line smoothing routine. 

Gaussian Smoothing 

Smoothens the terrain by providing a Gaussian weighting to the neighboring 

nodes. Gaussian smoothing is a surface smoothing routine. In most cases, Gaussian 

smoothing will smoothen the terrain more than the Bi-linear smoothing. An example will be a 

saddle point, where the second order derivative is positive along one of the axis and negative 

along the other, which the Bi-linear smoothing might fail to smooth to the given Terrain 

smoothing limit. 

Terrain Smoothing Limit 

In mathematical terms changes in the inclination are represented by the second order 

derivatives of the elevation. On specifying a value for the Terrain smoothing limit, all places 

where the second order derivatives are higher than the smoothing limit are smoothed in an 

iterative procedure, until the second order derivatives are less than the specified limit. 

Smoothing radius 

The Smoothing radius is used to define the area where the smoothing is applied, in 

accordance with the below setting of Gradual smoothing type. The Smoothing radius is 

defined as the radius of a circle centered in the mid-point of the simulation domain. 

The Smoothing radius has a value between 0 and 1, reaching the value 1 at the corners of 

the simulation domain. 

Gradual Smoothing Type 

The Gradual smoothing type is used to weight the smoothing in the inner or outer part of the 

simulation domain, preserving a continuous smoothing in the whole domain. The settings of 

the property variables Terrain smoothing limit, Smoothing radius and Gradual smoothing 

type allows for a wide range of terrain smoothing combinations. 

Inner 

Applies gradual smoothing from the center to the Smoothing radius and thereafter constant 

smoothing towards the border of the model, see definition sketch. 

Outer 

Applies no smoothing from the center to the Smoothing radius and thereafter a gradual 

smoothing towards the border of the model, see definition sketch. 
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Figure 6. Definition sketch for the Gradual smoothing type equal to Inner (top) and Outer (bottom), 

where R is the non-dimensional Smoothing radius. 

 5. Forest 

Forest 

By default the existence of a forest is disregarded. By changing the dropdown menu to Base 

on roughness height a forest can be considered by specifying a collection of parameters in 

the Forest setup. The forest is then associated to a certain roughness height present in the 

file grid.gws and is modelled by configuring the associated grid-cells. Here, source/sink 

terms 𝑆1, 𝑆𝑘 and 𝑆𝜖 are introduced in the governing equations as explained in the description 

of the Wind Fields module where they are specified. 

 

Forest setup 

Roughness height 

The roughness height to that the forest is assigned. A forest is established for all locations 

with this given roughness height in the grid.gws file. By default the Roughness height is set 

to 0.5 [m]. 
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Forest height 

The height of the forest. Default value is 30 [m]. 

Forest resistive force constant 𝐶2: 

The resistive force constant 𝐶2 is used to represent the forest as a resistive force proportional 

to the velocity squared  

𝑆2,𝑖 = −𝜌𝐶2 ∣ 𝑢 ∣ 𝑢𝑖 , 

where i indicates the component in space and ∣ 𝑢 ∣ is the magnitude of the wind velocity. By 

default the 𝐶2  is set to 0.1 [1/m]. Note that the parameters Forest porosity and Forest 

resistive force constant 𝐶1 no longer are used for the forest modelling in WindSim as they are 

incompatible with the current solvers.  

 

Forest turbulence sources 

Sources of turbulence are introduced in the 𝜅 and 𝜖 transport equations. Formally the model 

has been implemented as in Sanz (2003) [1] and Katul (2004) [2] with the model constants 

revised to be compatible with the default set of constants of the standard 𝜅 − 𝜖 model, 

𝑆𝑘 = 𝐶2( 𝛽𝑃 ∣∣ 𝑢 ∣3− 𝛽𝐷 ∣∣ 𝑢 ∣∣ 𝑘 ) 

𝑆𝜖 = 𝐶2

𝜖

𝑘
( 𝐶𝜖4𝛽𝑃 ∣∣ 𝑢 ∣3− 𝐶𝜖5𝛽𝐷+∣ 𝑢 ∣ 𝑘 ) 

With 𝛽𝑃 = 1.0, 𝛽𝐷 = 6.51, 𝐶𝜖4 = 1.24 and 𝐶𝜖5 = 1.24. 

 

 

Forest cell count in Z direction 

The number of cells in the vertical direction used for the forest can be specified by this 

variable. The cell distribution is uniform. The remaining number of cells used above the 

forest, is Number of cells in Z direction - Forest cell count in z direction. The vertical cell 

distribution could be inspected under the 3D model section in the Terrain report. By default 

the Forest cell count in Z direction is set to 3 [-]. 
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Wind Fields 

Generation of the wind fields 

Based on the generation of the 3D model in the preceding Terrain module, the simulation of 

the wind fields can now start. The wind fields are determined by solving the Reynolds 

Averaged Navier-Stokes equations (RANS). The standard 𝜅 − 𝜀 model is applied as 

turbulence closure. Since the equations are non-linear the solution procedure is iterative. 

Starting with the initial conditions, which are guessed estimations, the solution is 

progressively developed by iteration until a converged solution is achieved. 

The flow variables that are solved are: 

Pressure 𝑝 

Velocity components (𝑢, 𝑣, 𝑤) 

Turbulent kinetic energy 𝑘 

Turbulent dissipation rate 𝜀 

 

In more complex situations additional flow variables such as temperature 𝑇 can be included. 

The governing equations of the WindSim CFD model correspond to the RANS equations, 

assuming steady-state (derivatives in time are set to zero) and incompressibility (constant 

density). The conservation of momentum in the horizontal direction is expressed as 

 

𝑢𝑗  
𝜕𝑢𝑖

𝜕𝑥𝑗
= −

1

𝜌

𝜕 𝑝

𝜕𝑥𝑖
+

𝜕

𝜕𝑥𝑗
(𝜈  [

𝜕𝑢𝑖

𝜕𝑥𝑗
+

𝜕𝑢𝑗

𝜕𝑥𝑖
] − 𝑢𝑖𝑢𝑗) +

1

𝜌
 (𝑆1,𝑖 + 𝑆2,𝑖)  𝑖 = {1,2} , 

 

while mass conservation is ensured by (𝜕𝑢𝑖/𝜕𝑥𝑖 = 0). Here 𝜌 refers to the air density 

and 𝜈 is the air viscosity. The terms indicated by 𝑆1and 𝑆2 correspond to forest resistive 

forces as introduced in the Terrain module description. The conservation of momentum in 

the vertical direction has an additional forcing term when thermal effects (atmospheric 

stability) are taken into  

𝑢𝑗  
𝜕𝑢3

𝜕𝑥𝑗
=

𝜃0 − 𝜃

𝜃0
 𝑔 −

1

𝜌

𝜕 𝑝

𝜕𝑥3
+

𝜕

𝜕𝑥𝑗
(𝜈  [

𝜕𝑢3

𝜕𝑥𝑗
+

𝜕𝑢𝑗

𝜕𝑥3
] − 𝑢3𝑢𝑗) +

1

𝜌
 (𝑆1,𝑖=3), 

where 𝑔 is the gravitational acceleration, 𝜃 is the potential temperature and 𝜃0 is its reference 

value. For neutral simulations  𝜃 = 𝜃0  and therefore the extra forcing term vanishes. The 

potential temperature is influenced by advection, thermal diffusion and turbulent heat 

transfer, expressed as  

https://windsim.com/library/championship/2022%20Winner/report_export/ModuleDescriptions/Windfield_temperature.html
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𝑢𝑖  
𝜕𝜃

𝜕𝑥𝑖
=

𝜕

𝜕𝑥𝑖
(𝛼

𝜕𝜃

𝜕𝑥𝑖
− 𝑢𝑖𝜃  ′), 

where 𝛼 is the kinematic molecular diffusivity for heat in air. The turbulent terms in the 

Equations above are parametrized as follows 

𝑢𝑖𝑢𝑗 = −𝜈𝑇 [
𝜕𝑢𝑖

𝜕𝑥𝑗
+

𝜕𝑢𝑗

𝜕𝑥𝑖
] +

2

3
𝛿𝑖𝑗  , 

𝑢𝑖𝜃  ′ = −
𝜈𝑇

𝜎𝜃

𝜕𝜃

𝜕𝑥𝑖
 , 

where 𝜈𝑇 is the turbulence viscosity and 𝜎𝜃 = 1 corresponds to the turbulent Prandtl number 

for heat transfer. Additional information concerning the setup for the applied 𝜅 − 𝜀 closure 

can be found under Turbulence model. More details on the physical background of the model 

can be found in reports and publications on the WindSim web site. 

Boundary and initial conditions 

Along the borders of the 3D model, information about the flow field must be supplied. The 

wind flow solution obtained by a steady-state RANS model depends on these selected 

boundary conditions. These boundary conditions make explicit assumptions about the wind 

conditions, such as wind speed, wind direction, temperature and turbulence. The boundary 

conditions can be specified in two ways, either as analytical profiles or by nesting. 

The analytical wind profiles are empirical profiles over flat terrain. The vertical profiles are 

dependent on the roughness height and if the temperature is activated also on the stability of 

the atmosphere. There are associated profiles for the turbulence. In case of a neutral 

atmosphere the wind profiles are log profiles. Applying the log profile along the border is 

equivalent to the placement of an infinite flat terrain upstream of the 3D model. This might be 

a bad assumption, therefore the results along the borders should be treated with care. 

The nesting technique involves results from a former 3D model that fully covers the current 

3D model. The profiles at the boundaries are interpolated from the former 3D model. This 

former model can be a WindSim model or a mesoscale meteorological model. Likewise the 

initial conditions are interpolated from the former 3D model. Applying the nesting technique 

from a WindSim project reduces the inaccuracies introduced by applying the log profiles. It is 

highly recommended to start simulations in a large area and make refined models around the 

areas of interest using the nesting technique. 

Using the nesting technique from a meteorological mesoscale model gives the 

possibility of simulating special weather patterns. The information from the mesoscale model 

is interpolated to the WindSim grid as boundary and intial conditions. Meteorological data 

has to be given in an *.xyz format and needs to be converted into the WindSim 

format *.dws. This can be done using the meso-microscale coupling console under 

Tools → Open meso-microscale coupling console. 

https://windsim.com/library/championship/2022%20Winner/report_export/ModuleDescriptions/Windfield_mesoscale_nesting.html
https://windsim.com/library/championship/2022%20Winner/report_export/ModuleDescriptions/Windfield_xyz_format.html
https://windsim.com/library/championship/2022%20Winner/report_export/ModuleDescriptions/Windfield_dws_format.html
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To calculate the annual energy production from simulations nested with a meteorological 

mesoscale model, WindSim provides a methodology that utilizes the average mesoscale 

conditions per directional sector, described in Duran et al. [1]. This can be done using the 

meso-microscale coupling console under Tools → Open meso-microscale coupling console. 

The console will use the provided *.xyz timeseries and produce one *.xyz per directional 

sector. These files can be then converted into *.dws files, using the same console. 

Computer resources 

Be aware that 3D simulations can be quite demanding regarding computer resources and 

time. Typically, the simulation time is exponentially proportional to the number of cells in the 

model. It could be advantageous to split large models into smaller ones with the nesting 

technique. Running several simulations simultaneously is not recommended. 

Accuracy and convergence 

For descriptions on the accuracy and convergence of the wind field simulations please refer 

to accuracy and convergence. For general advice on how to achieve accurate and faster 

converging results with WindSim software, see Best Practices and Recommended 

Settings.  

Properties 

Boundary and initial conditions 

Do nesting 

Specify whether nesting from a WindSim project or from a mesoscale meteorological model 

should be activated or not. By default nesting is disregarded. 

Project file name 

In case nesting should be done From a WindSim project the name of the WindSim project as 

a .ws file has to be specified. The nesting project must surround the current project, except at 

the upper boundary. If the vertical extension of the current project goes above the nesting 

project a constant extrapolation will be applied. 

Folder for mesoscale data 

In order to do nesting From mesoscale the folder name where the *.dws files for this project 

are stored has to be specified. The nesting project must surround the current project 

completely. 

Sectors for next run 

file:///C:/Users/TorsteinSaeter/AppData/Roaming/WindSim/1200/ModuleDescriptions/WindField_accuracy.html
https://windsim.com/library/championship/2022%20Winner/report_export/ModuleDescriptions/WindField_convergence.html
https://windsim.com/library/championship/2022%20Winner/report_export/ModuleDescriptions/Windfield_dws_format.html
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The wind fields will be simulated for the sectors given in this list. Any wind direction can be 

given, but if climatology data is then introduced, it is recommended to simulate the same 

sectors as those found in the climatology data. For further processing of the modules Wind 

Resources and Energy there must be a correspondence between the sectors in the 

climatology and the sectors for which flow simulations are performed. Sector 0 gives wind 

from North, sector 90∘ gives wind from East etc. Default values are 12 sectors 

from 0 to 330∘. 

Sector Input Type 

The list containing the Sectors for the next run can either be inserted manually by choosing 

the option Manually set sector angles (the angles of interest have to be separated by a 

semicolon) or the list can be generated automatically by specifying the Number of 

sectors with the Uniform distrubution of sector angles option, here the full range of 360∘ is 

equally distributed into the indicated Number of sectors. 

Cases for next run 

When nesting is done from a mesoscale meteorological model then the wind field will be 

simulated for the cases given in this list. Any case number until 1000 can be given. 

Height of boundary layer 

The loglog profile as explained in Boundary and initial conditions is defined from ground 

up to the boundary layer height, above this height the profile is constant. Default value 

is 500m. 

Speed above boundary layer 

The constant speed above the boundary layer height. Default value is 10m/s. 

Use previous run as input 

If a wind field simulation has been undertaken for a sector, the simulation can be continued 

by using the restart facility. Restart means that the solution from the former run is used for 

the initial conditions. In situations when the number of iterations specified in the preceding 

simulations have not led to a converged solution, a restart could progress the solution further 

towards convergence. The restart is not yet available for simulations with temperature 

included and for simulations driven by meteorological data. Default value is False [-]. 

Boundary condition at top 

Three types of boundary conditions could be set at the top: fixed pressure condition, no-

friction wall or diffusive link (moving fixed pressure). The fixed pressure condition could be 

used on complex terrain, while the no-friction wall is for use over flat terrain, diffusive link is 
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like fixed pressure case but imposing a constant speed at the top. The imposition of a 

constant speed enables to lower the height of the model and use less cells vertically. 

Consider that no friction wall case is restricting the flow, no mass can flow out or in at all by 

the top boundary layer. Details on the behavior of the top boundary condition can be found 

under Documentation on the WindSim web site. Default value is Fixed pressure. 

 

Physical models 

Potential temperature 

Activation of the temperature equation. Depending on the type of initialization different 

boundary and initial conditions are set: 

Initialize from Monin-Obukhov length 

Depending on the given value for the Monin-Obukhov length the vertical profiles at the inlet 

are calculated stability dependend and a linear temperature gradient over the whole 

atmosphere is assumed. 

• Reference temperature: 

Potential temperature at sea level. Default value is 288 K. This value is only important 

for visualization purpose and does not influence the results. Select a value which is 

reasonable for your area. 

• Monin-Obukhov length: 

Stability Parameter with a range of -10000 to 10000 except 0. Default value is 100 m 

(very stable atmosphere). WindSim leaves the user the freedom to choose this 

parameter. Reasonable default values are |L| > 1000 for neutral atmosphere, 200 < L 

< 1000 for stable atmosphere and 0 < L < 200 for a very stable atmosphere. 0 > L > -

200 for a very unstable atmosphere and -200 > L > -1000 for an unstable 

atmosphere. As WindSim by default is setup to run steady state we do not 

recommend to run simulations with very unstable conditions as this can lead to 

divergence problems. 

• Reference height and Wind Speed in reference height: 

Depending on the stability of the atmosphere the wind profile in the higher elevations 

differs considerably (see Figure 7). It is therefore more convenient to prescribe a 

“reference speed” in a “reference height” near the surface (e.g. mean annual wind 

speed of your climatology). This can be done by these two parameters which are 0 by 

default. If both values are set to zero the “speed at boundary layer height” is used to 

calculate the boundary profiles. The boundary layer height has to have a reasonable 

value as it defines the height where the TKE gets zero and the wind profiles get a 

constant value. For stable simulations we recommend to use a boundary layer height 

of around 300 m and for unstable simulations of around 800 m. 

https://windsim.com/library/championship/2022%20Winner/report_export/ModuleDescriptions/Windfield_temperature.html
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 Figure 7. Wind speed profile for different Monin-Obukhov lengths (roughness length of 0.001 m). 

• Initialize from mesoscale: 

WindSim provides the possibility to derive the boundary conditions for temperature 

from a mesoscale meteorological model. Mesoscale temperature values are 

interpolated for the initialization of the CFD simulation. In Fig. 3, the temperature 

boundary conditions derived from analytical profiles and from a mesoscale model are 

compared. 
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Figure 8. Example of potential temperature fields obtained from an analytical model (top panel) and 

from a mesoscale model (bottom panel). 

Air density 

This is the air density used in the CFD simulations [kg/m3]. 

Turbulence model 

The first turbulence model is the standard 𝜅 − 𝜀 model. The 𝜅 − 𝜀 model belongs to the family 

of eddy viscosity models, the eddy viscosity 𝜈𝑇  is calculated by the following analytical 

equation. 

𝜈𝑇 = 𝐶𝜇  𝑘2/𝜀 

A version with modified model constants is also available [2], please refer to the section 

"Library/Papers & Presentations/" at WindSim for details. For high turbulent Reynolds 

numbers, the standard form of the  𝜅 − 𝜀 model may be summarised as follows 

𝜕(𝑢𝑖  𝑘)

𝜕𝑥𝑖
=

𝜕

𝜕𝑥𝑖
[
𝜈𝑇

𝜎𝑘

𝜕𝑘

𝜕𝑥𝑖
] − 𝜀 + 𝑃𝑘 + 𝑃𝑏 +

1

𝜌
 𝑆𝑘   

𝜕(𝑢𝑖  𝜀)

𝜕𝑥𝑖
=

𝜕

𝜕𝑥𝑖
[
𝜈𝑇

𝜎𝜀

𝜕 𝜀

𝜕𝑥𝑖
] − 𝐶𝜀2

𝜀2

𝑘
+ 𝐶𝜀1

𝜀

𝑘
(𝑃𝑘 + 𝐶𝜀3  𝑃𝑏) +

1

𝜌
𝑆𝜀 

 

Here 𝜅 is the turbulent kinetic energy and 𝜖 is the dissipation rate, 𝜌 is the fluid density 

and 𝜈𝑇  is the turbulent kinematic viscosity. 𝑆𝜖 and 𝑆𝜅 are due to the forest resistive forces as 

introduced in the Terrain module description. The additional kinetic and thermal 

contributions 𝑃𝑘  and 𝑃𝐵 are given  

𝑃𝑘 = 𝜈𝑇 [
𝜕𝑢𝑖

𝜕𝑥𝑗
+

𝜕𝑢𝑗

𝜕𝑥𝑖
]

𝜕𝑢𝑖

𝜕𝑥𝑗
 ,  

http://windsim.com/
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and  𝑃𝑏 = −
𝜈𝑇

𝜎𝜃

𝑔

𝜃

𝜕 𝜃

𝜕𝑥3
  

The term covered by 𝑃𝐵 introduces thermal effects to the model and is therefore only present 

if the Potential temperature is included, otherwise 𝑃𝐵 = 0. The values of the model constants 

in Standard 𝜅 − 𝜀 model are given as follows. 

 

𝑪𝝁 𝝈𝒌 𝝈𝜺 𝑪𝜺𝟏 𝑪𝜺𝟐 𝑪𝜺𝟑 

0.09 1.0 1.314 1.44 1.92 1.0 

 

The values of the model constants in Modified 𝜅 − 𝜀 model are given as follows. 

 

𝑪𝝁 𝝈𝒌 𝝈𝜺 𝑪𝜺𝟏 𝑪𝜺𝟐 𝑪𝜺𝟑 

0.0324 1.0 1.85 1.44 1.92 1.0 

 

The constants are modified to better fit experimental data of the Atmospheric Boundary 

Layer, as described in [2]. 

In WindSim two further modifications of the 𝜅 − 𝜀 model are available: the YAP correction [3] 

and the RNG (ReNormalization Group) version [4]. The Yap correction adds a term to 

the ε equation, this correction is reported to provide much-improved predictions in separated 

and reattaching flowsway. It gives better results in case of flow separation, the models 

constants are the same as Standard 𝜅 − 𝜀 model. RNG techniques have been used to 

develop a theory for the large scales in which the effects of the small scales are represented 

by modified transport coefficients. The obtained model differs from the Standard 𝜅 − 𝜀 model 

in the set of constants used and has an additional term in 𝜀 equations. RNG model has 

proved better results in case of flow separation. The values of the model constants in 

RNG 𝜅 − 𝜀 model are given as follows. 

 

𝑪𝝁 𝝈𝒌 𝝈𝜺 𝑪𝜺𝟏 𝑪𝜺𝟐 𝑪𝜺𝟑 

0.0845 0.7194 0.7194 1.42 1.68 1.0 

 

The boundary conditions of model at the inlet are set for 𝜅 and 𝜀 with vertical profiles as 

described in [2], 𝑪𝝁 constant affects the  𝜅 profiles and is modified accordingly to the 

turbulence model selected. 

http://windsim.com/
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Calculation parameters 

Solver 

During the infancy of Computational Fluid Dynamics, only algorithms with small demands on 

computing power could survive. Computer memory was then extremely rare and expensive. 

In this context, use of the Patankar-Spalding SIMPLE algorithm and its descendants 

(SIMPLER, SIMPLEC, SIMPLEST, PISO...), based on the segregation of momentum and 

continuity equations was the best strategy to adopt. This strategy used to be activated with 

the segregated solver which today is obsolete. 

But as the number of cells increases, the elliptic nature of the pressure field becomes a 

penalty and the global convergence of the method strongly slows down. The present state of 

the technology opens doors to other ways of thinking. The mean amount of RAM on PCs is 

continually increasing and its price decreasing so that, in many case, refining a grid up to the 

computer storage capability leads to some huge CPU times to convergence. Therefore, as 

soon as the bottleneck becomes the required time for the solution, we had some other 

options. 

Convergence problems can be overcome by using the General Collocated Velocity method 

(GCV). The method uses a segregated pressure-based solver strategy with an additional 

correction of cell-centre momentum velocity components, which provides faster convergence 

in comparison with the standard one-step face velocity correction. The pressure-velocity 

coupling algorithm is based on a linearisation which is similar to the well known SIMPLEC 

procedure, and is generalised for arbitrary BFC geometries. The linear equation solver is 

based on the conjugate-residual algorithm with LU preconditioning. 

The convergence with an increasing number of cells can also be handled by using the 

parallel GCV solver. The solver makes it possible to split the simulation area into several 

domains which are calculated seperately. This speeds up the calculation process if several 

CPUs are available. 

Hypre [6] is a library of high-performance preconditioners and solvers, with BoomerAMG 

enabled in WindSim. This uses algebraic multigrid (AMG) algorithm for the linear equation 

solver for the GCV algoritm. The new solver setup shows a better convergence behavior for 

big models run with parallel option. This solver enables future development to solve on semi-

structured grid. 

Number of simultaneous sectors 

Number of sectors which will be run simultaneously. The maximum number is limited to the 

number of CPU's of the machine. 

Number of CPU's per sector 
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For the parallel solver version the domain of each sector can be additionally split into several 

subdomains which are calculated on different CPU's (1,2,4,8...). The number of simultaneous 

sectors times the number of CPU's per sector should not be higher then the total number of 

CPU's available. 

Number of iterations 

With the Number of iterations the maximal number of iterations that will be performed in the 

non-linear solution procedure is determined. The iteration is either stopped if 

the Convergence criteria is fulfilled (see below) or if the Number of iterations is reached. The 

number of iterations necessary to obtain a converged solution will depend on the number of 

cells.  

Convergence criteria 

The simulations are stopped automatically when a certain level of convergence is reached. 

For this purpose the sums of absolute imbalances of the solved variables are calculated and 

then normalized by a reference value. If the normalized values fall below the given 

convergence criteria for all solved variables the simulation will stop. The default value is 

0.0005). 

Convergence monitoring 

Coordinate system 

The spot value position is referenced to the local or global coordinate system. The local 

coordinate system has its origin in the lower left-hand corner of the 3D terrain model. The 

global system is the system specified in the grid.gws file. Default value is Local [-] 

Spot value X and Y position 

The spot value position is by default set to the centre of the terrain at ground level (𝑛𝑥/2, 

𝑛𝑦/2,1), where 𝑛𝑥  and 𝑛𝑦 is the number of cells in 𝑥 and 𝑦-direction. The spot value position 

can be set anywhere in the horizontal plane. This allows monitoring of the development at 

points of special interest, like climatology and turbine positions. For details refer 

to convergence. 

Field value to monitor 

The field value allows the user to choose a solved variable and follows the development of 

this variable as the solution procedure progresses. The field variable is presented for the 

plane (𝑛𝑥/2, 𝑛𝑦/2,1), where 𝑛𝑥  and 𝑛𝑦 is the number of cells in 𝑥 and 𝑦-direction. With this 

information available it should be easier to introduce measures to ensure convergence even 

for very complex models. 

https://windsim.com/library/championship/2022%20Winner/report_export/ModuleDescriptions/WindField_convergence.html
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Output  

Height of reduced wind database 

The results from the wind field simulations are stored in a compressed database consisting 

of flow variables, derived variables and auxiliary variables. In order to speed up the 

extraction of the data used in other WindSim modules a reduced database is also stored. In 

this database only the flow variables 𝑢, 𝑣, 𝑤 and 𝑘 are stored from the ground and up to the 

specified Height of reduced wind database herein. Default value is 300 m. 

XY reduced wind database 

Activating this option, if the horizontal grid is defined with a refinement type (Refinement 

area, Refinement file or Actuator Disc) the following modules is performed only on the 

internal part of the horizontal grid. Similarly to the vertical “Height of the reduced wind 

database”, the solver is solving the equations on the complete grid but the outer part is 

disregarded by the postprocess. This option enables lighter and faster run of next modules, 

obtaining a uniform grid out of a refinement case. 

Actuator disc 

The cells covering the swept area A exert forces directed against the wind in the axial 

direction. For the new actuator disc method presented in Simisiroglou et al. [5] the thrust 

force 𝐹𝑖 at each cell of the actuator disc is calculated from 

𝐹𝑖 =
1

2
𝜌 𝐴𝑖  (

𝑈1,𝑖

1 − 𝑎𝑖
)

2

 𝐶𝑇(𝑈1,𝑖)  (1)     

 

Where  (𝑈1,𝑖), is the velocity of the flow at 𝑖-th cell of the disc perpendicular to the disc, 𝑎𝑖 is 

the axial induction factor calculated for each individual cell of the disc,  is the surface area of 

the cell facing the undisturbed wind flow direction and 𝐶𝑇(𝑈1,𝑖) is a modified thrust coefficient 

dependent on the velocity at the disc 𝑈1,𝑖 and 𝜌 is the air density. In most cases wind turbine 

manufacturers offer 𝐶𝑇 as a function of 𝑈∞ the undistributed wind velocity. This 𝐶𝑇 is 

reasonable for the first wind turbine of the row but not for the downstream wind turbines 

where the flow has been disturbed. Hence, in the present case a 𝐶𝑇 which is a function of 𝑈1, 

representing the velocity at the disc, is needed. This function can be established from the 1D 

momentum theory by combining the definition of the trust coefficient 𝐶𝑇 and the axial 

induction factor 𝑎: 

𝐶𝑇 = 4𝑎 (1 − 𝑎) ,      (2) 

𝑈1 = (1 − 𝑎) 𝑈∞  .      (3) 

 

Hence from Eq. (2) and Eq. (3) the following is obtained 
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𝑈1 =
1

2
 𝑈∞  (1 + √1 − 𝐶𝑇(𝑈∞))   .  (4)    

 

 

References 

[1] Duran, P., Meissner, C., Casso, P. "A new meso-microscale coupled modelling framework 

for wind resource assessment: A validation study." Renewable Energy Journal, Vol. 160, 

pp538-554, 2020. 

[2] Arne R. Gravdahl. VECTOR AS "Meso Scale Modeling with a Reynolds Averaged Navier-

Stokes Solver Assessment of wind resources along the Norwegian coast" 31th IEA Experts 

Meeting – State of the Art of Wind Resource Estimation, Risø 1998. 

[3] Yap, C. J. "Turbulent Heat and Momentum Transfer in Recirculating and Impinging 

Flows." PhD Thesis, Faculty of Technology, University of Manchester, United Kingdom, 

1987. 

[4] Yakhot, V., Orszag, S.A., Thangam, S., Gatski, T.B. & Speziale, C.G. "Development of 

turbulence models for shear flows by a double expansion technique." Physics of Fluids A, 

Vol. 4, No. 7, pp1510-1520, 1992. 

[5] Simisiroglou, N. "Wind power wake modelling: Development and application of an 

actuator disc method for industrial utilization." PhdThesis, p.50, 2018. 

[6] V.E. Henson and U.M. Yang, BoomerAMG: a Parallel Algebraic Multigrid Solver and 

Preconditioner, Applied Numerical Mathematics, 41 (2002), pp.155-177. UCRL-JC-141495. 

 

Objects 

Placing the objects 

The Objects module is used to position turbines, climatologies and transferred climatologies. 

These objects can be placed directly using the Park layout interface. 

Alternatively, objects can be read from a .ows files using the Tools → Import objects menu 

item. For visualisation purposes various geometrical objects can also be placed into the 3D 

terrain model by using the OpenGL Pro application. The current 3D terrain model is 

accessible within the OpenGL Pro environment by clicking the 3D button in the upper right 

corner of the Report section. 
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Climatology conversion 

If the climatology data is not given in the WindSim formats .wws, or .tws, a conversion is 

necessary before the data can be used within WindSim. 

One possibility is to convert your climatology data directly to the format by using your own 

tools, see: climatology data. 

Alternatively, the conversion from other formats can be performed by clicking 

the Tools → Convert climatology data menu item as described below under Climatology file. 

The Convert climatology data is subject to continuous development, so please contact 

WindSim AS if you need extensions in order to perform the conversion of your specific data, 

see examples of supported climatology formats: third party formats. 

 

Properties 

1. Object definition 

Object type 

Setting the object type as Turbine, Climatology or TransferredClimatology. Default value is 

Turbine [-]. 

Name 

Name of the object. 

Reliability 

Reliability is a value between 0 and 1 that represents the trust in the climatology. The trust 

can vary due to the type of measurement (e.g. a measurement mast has a higher trust than a 

lidar) and due to the length of the measured period. If the quality of the measurements is 

very good (e.g. class 1 anemometer and more than a year of measurements) then the 

reliability should be set to 1. Accordingly, the reliability should be decreased depending on 

the trust. The Reliability is used in the Wind Resources and Energy calculation when the 

results are weighted against all climatologies. In both calculations the climatology weighting 

factor obtained from the inverse of the distance will be multiplied by the Reliability value. 

Setting the Reliability to 0 will cause the climatology to be disregarded in the Wind 

Resources and Energy calculation. 

Visualisation file 

Specification of a file with geometry used for visualisation. For Turbine objects it is 

recommended to use turbin_n (n is a height in m), which automatically generates simple 

https://windsim.com/library/championship/2022%20Winner/report_export/ModuleDescriptions/Climatology_data_format.html
https://windsim.com/library/championship/2022%20Winner/report_export/ModuleDescriptions/Climatology_third_party_format.html
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scaleable geometries in accordance with the legend in the report section. Likewise for 

climatology and climatology transfer objects it is recommended to use climatology_n (n is a 

height in m). Default value depends on Object type. [-] 

Climatology file 

Specification of a climatology file. Climatologies can be converted from other formats by 

clicking the Tools → Convert climatology data menu item. Note that all climatology formats 

should be compatible with each other and wind data has to be available for all sectors 

specified in the climatologies to be evaluated in the Wind Resources or Energy module. 

If the object type is TransferredClimatology then the specification of an existing climatology 

file used within the project will be transferred to a new position. Any x and y coordinates 

within the model is allowed, but there is a restriction on the z values. The z values must be 

above the first computational node, which varies according to the resolution in the given 

model. A warning is given if a value below the allowed minimum is given. The height of the 

reduced wind database, specified under the Wind Fields module defines the maximum 

possible z value. The transferred climatology will be placed in the climatology folder with the 

prefix trans_ added to the original file name. 

The option of transferring climatologies is useful for cross checking and for successive 

transfer of climatologies over larger distances. By transferring a climatology to higher 

altitudes in a refined model, small scale effects are filtered out. Now the transferred 

climatology can be used in a coarser model for transfer over larger distances. Finally, the 

climatology can be imported again in new refined models. 

Note that transferred climatology objects within a model are not used in the Wind 

Resources and Energy modules, as they don't provide any new information. A climatology 

transferred from an external model will provide new information, these climatologies can be 

included as ordinary climatology objects. Default value is none [-]. 

Power curve file 

Specification of a power curve file in WindSim format .pws. If the power curve for a certain 

turbine type is not available in the WindSim database ("%ProgramFiles%/WindSim/WindSim 

12.0.0/Data/Objects/Power Curve") you can write it with Tools → Create power curve 

(.pws) or in a text editor taking into account the required syntax. Default value is none [-]. 

Hub height 

Turbine hub height in [m]. Default value is 80 m. 

Rotor diameter 

Turbine rotor diameter in m. Default value is 60 m. 

file:///C:/Users/TorsteinSaeter/AppData/Roaming/WindSim/1200/ModuleDescriptions/WindResources.html
file:///C:/Users/TorsteinSaeter/AppData/Roaming/WindSim/1200/ModuleDescriptions/WindResources.html
file:///C:/Users/TorsteinSaeter/AppData/Roaming/WindSim/1200/ModuleDescriptions/Energy.html
https://windsim.com/library/Module%20Overview/WindSim%20-%20Objects.html
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Rotation speed 

The rotational speed of the turbine blades or the climatology anemometer. Default value is 

10 (rounds per minute) for turbines and 25 (rounds per minute) for climatologies. 

Facing wind direction 

The direction to which the turbines surface is aligned perpendicular can be determined here. 

The angle needs to be specified in degrees measured clockwise from North. The default 

value is 180 degrees, meaning that the turbine is oriented towards the South. This option is 

only important for visualization purposes. 

Number of Sectors 

In order to process climatology data given in a .tws format WindSim rewrites this information 

into a frequency distribution format (see climatology data). The number of sectors that are 

used in this frequency distribution can be specified here. 

Number of Bins 

In order to process climatology data given in a .tws format WindSim rewrites this information 

into a frequency distribution format (see climatology data). The number of bins that are 

used in this frequency distribution can be specified here. 

 2. Position 

Coordinate system 

The position of an object is always referring to a certain reference frame, here given by either 

the local or global coordinate system. The local coordinate system has its origin in the lower 

left-hand corner of the 3D terrain model (see Terrain ) while the global system is the system 

specified in the grid.gws file. Default value is Local [-]. 

X and Y position 

The X and Y position of the objects according to the specified coordinate system. For 

Climatology objects additionally the z position is shown, the position for climatologies cannot 

be changed because it is already specified in the .wws file. The .wws file can be opened in a 

text editor by clicking the Tools → View climatology data (.wws) menu item. 

 3. Noise calculation 

Based on broadband 

A map of sound pressure level (𝐿𝑝)[𝑑𝐵(𝐴)] is calculated at the Noise map height, optionally 

accounting for the background sound level. The noise level is calculated for a particular wind 

http://windsim.com/
https://windsim.com/library/championship/2022%20Winner/report_export/ModuleDescriptions/Climatology_data_format.html
http://windsim.com/
https://windsim.com/library/championship/2022%20Winner/report_export/ModuleDescriptions/Climatology_data_format.html
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condition specified by the user. Therefore a wind speed at a given height has to be specified 

by the user. WindSim will calculate for the assigned wind condition the wind speed at each 

hub position, according to the Wind Fields calculations, and the relative sound power level 

Lw. To estimate the power level, the wind speed at the hub is transferred to the reference 

height assigned in the .pws file by using a power law with a wind-shear exponent of 1/7. 

The sound pressure level (𝐿𝑝𝑖(𝑥, 𝑦)) at a generic point (𝑃(𝑥, 𝑦)) produced by the i-th wind 

turbine is given by: 

𝐿𝑝𝑖(𝑥, 𝑦) = 𝐿𝑤𝑖 − 10 log(2𝜋𝑑𝑖
2) − 𝛼 𝑑𝑖 

where: 

(𝐿𝑤𝑖) - broadband sound power level ([dB(A)]) of turbine 𝑖, 

(𝑑𝑖) - distance of (𝑃(𝑥, 𝑦)) to the 𝑖-th turbine [m], 

(𝛼)- broadband attenuation coefficient ([dB(A)/m]) 

While the sound pressure levels due to the different wind turbines, and eventually the 

background sound pressure level, are summed according to the decibels rules. 

𝐿𝑝(𝑥, 𝑦) = 10 log (∑ 100.1 𝐿𝑝𝑖

𝑖

+ 100.1 𝐿𝑝𝑏𝑔 ) . 

Noise map height 

The height at which the sound map is extracted. The map height [m] is given as a real 

number. 

Background noise 

Optional background noise for the sound pressure level calculation [dB(A)]. A default value of 

0 will produce a map not accounting for background noise. 

Attenuation coefficient 

Broadband attenuation coefficient [dB(A)/m] to account for the noise absorption of the air. 

Noise at height 

Height above ground level at which the wind speed and direction condition is assigned [m]. 

Noise coordinate system 

Specify which coordinate system Global/Local is used to assign the X and Y coordinate at 

which the wind conditions (wind speed and direction at Noise at height) are given.direction 

at Noise at height) are given. 

Conditions X position 

X (easting) coordinate of the point used to specify the wind conditions. 
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Conditions Y position 

Y (northing) coordinate of the point used to specify the wind conditions. 

Noise at wind speed 

Wind speed condition at which the noise map is calculated ([m/s]). 

Noise at wind direction 

Wind direction condition, measured clockwise from north, at which the noise map is 

calculated ([deg]). 

 

 4. Terrain Complexity 

Terrain complexity calculation is performed at each turbine position and climatology position, 

following the IEC 61400-1:2019 [1]. The terrain points near the turbine position are divided 

into sectors of different radius and angle amplitude: 5 hub height per 360-degree amplitude 

and 5,10 and 20 hub height per 30-degree amplitude. For each sector a plane is fit to the 

points (the plane is not passing through the tower base), then the inclination angle (slope) is 

detected and the standard deviation of the terrain variation is calculated by the distance of 

terrain points from the plane. 

The TSI (Terrain Slope Idex) and TVI (Terrain Variation Index), as defined in the IEC 

standard, are obtained by using this information and the energy frequency per direction. The 

energy frequency that is used is obtained by the first climatology of the layout. TSI and TVI 

are compared to category limits to define Low, Medium and High (L, M and H) complexity 

categorization. The highest category of all the sectors cosidered is defined as the complexity 

category at that position. More details on the calulation are availble in [1]. 

The results of the terrain complexity following IEC 61400-1:2019 are stored in the layout 

subfolder “/report/TerrainComplexity” and displayed via the links in object module report. The 

calculation of complexity Indexes according to previously defined standards are still 

perfomed and the results are available in the layout subfolder 

“/report/TerrainComplexityPreviousCalc”, see terrain complexity for more details. 

 

 

[1] International Electrotechnical Commission (IEC). IEC 61400-1 ed4.0 (2019), Wind turbine 

generator systems - Part 1: Safety requirements [chapter 11.2.1 Assessment of the 

topographical complexity] 

 

https://windsim.com/library/championship/2022%20Winner/report_export/ModuleDescriptions/Objects_terrain_complexity.html
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Results 

Exploring the wind database 

The results of the wind field simulations are stored in a reduced database covering the 

vertical extension from ground up to the Height of reduced wind database as specified in 

the Wind Fields module. The Results module extracts 2D horizontal planes from this 

database. 

For inspection of the 3D set, use the 3D Visualisation → Generate/Open 3D wind 

visualisation file (.vtf) 

Properties 

 1. Normalisation  

Normalisation variable 

The following variables are available: 

Speed scalar X - wind speed scalar in East-West direction, (𝑢 [m/s]). 

Speed scalar Y - wind speed scalar in North-South direction, (𝑣 [m/s]). 

Speed scalar Z - wind speed scalar in vertical direction, (𝑤 [m/s]). 

Speed scalar XY - wind speed scalar in horizontal plane, (√𝑢2 + 𝑣2 [m/s]). 

Speed scalar XYZ - wind speed scalar in 3D space, (√𝑢2 + 𝑣2 + 𝑤2 [m/s]). 

Velocity vector XY - wind speed vector in horizontal plane, ((𝑢, 𝑣, 0)). 

Velocity vector XYZ - wind speed vector in 3D space, ((𝑢, 𝑣, 𝑤)). 

Direction scalar - wind direction in horizontal plane ([deg]). 

Direction scalar relative - wind direction in horizontal plane relative to incoming wind 

direction ([deg]). 

Turbulent kinetic energy - Turbulent kinetic energy, (𝑘 [m2/s2]). 

Turbulence intensity - Turbulence intensity assuming 

isotropic (𝑘), (100√(4 𝑘)/[3 (𝑢2 + 𝑣2)])[%]. 

Turbulent dissipation rate/Turbulent Frequency (𝜖/𝜔 [m2/s2]). 

Pressure - relative pressure: fixed zero at sea level, minus the hydrostatic term, ([Pa]). 

Inflow angle - angle with respect to the horizontal, (arctan(𝑤/√𝑢2 + 𝑣2) [deg]). 

Wind shear exponent – exponent  (𝛼) of the equation (speed1/speed2 = (height1/

height2)𝛼  )[−]. 

Normalisation type 
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The following normalisation types are available: 

Not normalized - Present results with no normalization. 

Normalize against climatology - Normalization against the first visible Climatology object. 

Normalize against scalar value - Normalize against the scalar value specified in Scalar value. 

Scalar value 

Value used in normalization when Normalization type is Normalize against scalar value. 

2. Planes 

Heights 

The Heights above ground level for which the results should be generated. Only heights 

below the Height of reduced wind database specified in the Wind Fields module are valid. 

Multiple heights can be given as a semicolon separated list, e.g. 50;60;70. 

Sector angles 

The sector angles for which the results should be generated. Only sector angles where wind 

field simulations have been performed are valid. Several sector angles can be given as a 

semicolon separated list, e.g. 0;30;60;90. 

 

 3. Legend 

Legend minimum and maximum values 

Specification of the legend interval, if both minimum and maximum are set to zero the full 

range will be given. Default value is zero [-]. 

 

 

Wind Resources 

Accumulation of results - the wind resource map 

Before running the Wind Resources module at least one climatology must exist and all 

sectors defined in that climatology must exist in the wind database. The wind resource map 

is established by weighing the wind database against the climatology. If several climatology 

objects are available the wind resource map will be based on them all, by interpolation of the 

inverse distance to the climatology objects. 
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The Wind Resources module contains a tool for area classification. Finding high speed 

connected areas where the areas are grouped according to the wind speed and size. The 

possible power production in the area is also estimated. 

Properties 

1. Wind resource map 

Heights 

Here the height for which the results should be generated has to be specified in units of 

meter [m]. With a semicolon separated list there is also the possibility to generate results for 

multiple heights. Note that only heights below the "Height of reduced wind database" in 

the Wind Fields module are valid. Default value is 50 [m]. 

Sector interpolation 

The wind direction for a simulation in the wind database refers to the wind direction at the 

inlet. Due to terrain effects the wind direction changes in the inner of the model. In order to 

weight the wind database against a climatology, an interpolation is required to reproduce the 

sectors of the climatology at the climatology position, see example in figure 9. A sector 

interpolation for all sectors in the climatology is performed when sector interpolation is True. 

The default value is True [-]. 

 

Figure 9. Example of sector interpolation, where interpolation of incoming wind from North-northwest 

and North give wind from North at the climatology location. 
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Wake effects 

Wake effects can either be assessed by analytical models or by CFD based methods itself. 

Regarding a CFD based approach, WindSim provides the modeling of a single turbine within 

an actuator disc approach which is directly included into the CFD calculation. In order to 

setup a calculation containing the actuator disc model one has to return to 

the Terrain module an choose the actuator disc refinement option as described in 

the Terrain description. 

Analytical methods are attractive since they are simpler and less computational demanding 

than CFD based methods. In the following the three analytical wake models that can be used 

in WindSim are described, they are all single wake models calculating the normalized 

velocity deficit (𝛿𝑣 = (𝑢 − 𝑣)/𝑢), as shown in figure 10. Since the area which is influenced by 

wake effects is modeled for instance as a cone, all models are rotationally invariant as 

represented in figure 10, where the x-axis is shown at hub height. 

 

Figure 10. Definition sketch of wake effects. 

 

Since the velocity deficit is calculated based on the wind database established in the 

module Wind Fields the analytical wake modeling is a post-processing procedure. 

Consequently, the mutual interaction between the wakes as well as the interaction between 

the wakes and the terrain can not be captured correctly within this approach. Alternatively, 

each turbine can be modeled as a disc within the actuator disc approach in 

the Terrain module. The presence of all turbines can therefore be included in the CFD 

simulation and wake-wake effects as well as terrain-wake effects can be considered. 

Model 1 

Model 1 is based on momentum deficit theory and is often referred to as the "Jensen model" 

[1]. This model gives a simple linear expansion of the wake, determined by the wake decay 
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factor kk. The wake decay factor increases with increasing level of ambient turbulence, a 

typical range is from 0.04 to 0.075 

𝛿𝑉 =
1

9
 (𝐶𝑇  𝐴𝑟  𝑥−2)1/3[𝑟3/2 (3 𝐶1

2  𝐶𝑇  𝐴𝑟  𝑥)−1/2 − (35/2𝜋)3/10(3 𝐶1
2)−1/5]

2
 

 

Where 

𝐶𝑇 - thrust coefficient 

𝑘 = 𝐴/𝑙 𝑛(ℎ/𝑧0) 

𝐴 =  0.5 

ℎ - hub height [m] 

𝑧0 - roughness height [m] 

 

Model 2 

Model 2 is derived from the turbulent boundary layer equations and a similarity assumption. It 

is often referred to as the "Larsen model"[2]. 

𝛿𝑉 =
1

9
 (𝐶𝑇  𝐴𝑟  𝑥−2)1/3[𝑟3/2 (3 𝐶1

2  𝐶𝑇  𝐴𝑟  𝑥)−1/2 − (35/2𝜋)3/10(3 𝐶1
2)−1/5]

2
 

where 

𝐶𝑇 - thrust coefficient [-] 

𝐴𝑟 = 𝜋 𝐷2/4 

𝐷 - rotor diameter 

𝐶1 = (𝐷/2)5/2(𝐶𝑇  𝐴𝑟  𝑥0)−5/6 

𝑥0 = 9.5 𝐷4/(2 𝑅95)3 − 1 

𝑅95 = 0.5 (𝑅𝑛𝑏 + min(ℎ, 𝑅𝑛𝑏)) 

𝑅𝑛𝑏 = max(1.08 𝐷, 1.08 𝐷 + 21.7 𝐷 (𝐼𝑎 − 0.05)) 

𝐼𝑎 - ambient turbulent intensity at hub height 

Model 3 

This model introduces a turbulent depending rate of wake expansion [3]. 

𝛿𝑉 = 𝐶𝑇
1/2

 (1.666/𝑘1)2  (𝑥/𝐷)−𝑝 exp(−𝑟2/𝑏2) /32 

where 

𝐶𝑇  - thrust coefficient [-] 

𝑏 = 𝑘1  (𝐶𝑇
1/4

/0.833) 𝐷(1−𝑝/2) 𝑥𝑝/2 

𝐷 - rotor diameter 

𝑝 = 𝑘2  (𝐼𝑎 + 𝐼𝑤) 

𝐼_𝑤 =  𝑘_3  (𝐶_𝑇/ max (𝐼_𝑎, 0.03)) (1 − exp(−4 (𝑥/10 𝐷)2)) 

𝐼𝑎 - ambient turbulent intensity at hub height 
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𝑘1 = 0.27 

𝑘2 = 6.00 

𝑘3 = 0.004 

 

Wake Decay Factor 

If Model 1 is chosen to simulate wake effects the corresponding wake decay factor 𝑘 as 

described above can be manually specified to a fixed value. If the default option Automatic is 

active the wake decay factor is determined as described in the corresponding model 

description. 

 

Roughness 

Here the roughness height at the position of the turbine should be given as an input 

parameter to wake Model 1. This value can either be read from the .gws file or it can be 

specified manually as a constant value. By default the roughness height is read from the 

.gws file. 

Ambient turbulence intensity 

The ambient turbulent intensity at the turbine position is an input parameter to wake Model 2 

and wake Model 3. This value can either be read from the wind database or it can be 

specified manually as constant value. By default the ambient turbulent intensity is read from 

the wind field database. 

Number of sub-sectors 

In order to refine the calculation of wakes for one sector the sector is additionally divided into 

sub-sectors for which the wakes are calculated. The total wake representative for the sector 

is subsequently calculated by an appropriate average. The default Number of sub-

sectors is 30[-]. 

Influence range 

The influence range in units of rotor diameters determines the area where the wake 

calculation is performed. Here one has to specify a minimum and a maximum value 

(seperated by a semicolon) corresponding to the lower and upper radial limit of the waked 

area. The lower limit is used to disregard wake effects in the near-field that might not be 

represented correctly by the considered wake model. The upper limit is given for 

computational reasons, to avoid calculations in the far-field where wake effects could be 

neglected. The default range is (1;50) [Rotor diameter]. 
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Multiple wakes model 

When more than one turbine influence the velocity at the considered location the velocity 

deficits calculated by the analytical single wake models are combined to obtain a total wake 

deficit. In the literature several multiple wake models have been proposed to describe the 

combined wake effect on the basis of the single wake contributions. In WindSim the linear 

superposition of the wake deficts (1) and the square root of the sum of the squares (2) is 

supported. The total wake deficit 𝛿𝑣 is composed of the single velocity deficit 𝛿𝑣𝑖 associated 

to one turbine 𝑖, where the sum over all turbines is performed as follows. 

(1) Based on linear superposition 𝛿𝑣 = ∑ 𝛿𝑣𝑖𝑖   

(2) Based on sum of squares of velocity deficits 𝛿𝑣 = √∑ 𝛿𝑣𝑖
2

𝑖  

Air density correction 

Activating Export to WAsP format the wind power density calculation is activated and density 

calculation is done in every grid point. Choose the desired density correction. The default 

value is "no correction". 

No correction 

The density at all points equals the density in the power curve file. 

Fixed Value 

The density at all points equals the given value. 

Individual 1 

The density is calculated at each point from the U.S. Standard Atmosphere considering 

elevation changes 𝜌 = 1.225 − (1.194 ⋅ 10−4) 𝑧, where 𝑧 is the height above sea level. This 

will give a good long-term average value of air density in moderately complex areas. 

Individual 2 

The density is calculated at each point from an isothermal atmosphere approximation to 

account for elevation changes and mean site temperature 𝜌 =
𝑝0

𝑅⋅𝑇
  exp (

−𝑔

𝑅⋅𝑇
 𝑧), where 𝑝0 ≃

1013.25 hPa is the standard sea level atmospheric pressure,  𝑔 ≃ 9.8 m/s2 is the gravitational 

constant, 𝑇 is the temperature in units of Kelvin as specified under Reference 

temperature, 𝑅 is the gas constant and 𝑧 the height above sea level. 

Individual 3 

The density is calculated at each point from the standard atmosphere with an assumed 

temperature lapse rate that is determined by the input parameter Temperature 

gradient below. The pressure is again assumed to be  𝑝0 ≃ 1013.25 hPa at sea level. 

Additionally, a reference temperature at a certain reference height needs to be specified. 

• Reference height: 

Here the Reference height associated to the indicated Reference temperature has to 

be determined. Default value is 0[m]. 
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• Reference temperature 

Here the Reference temperature as input parameter for an Air density correction of 

the type Individual 2 or Individual 3 has to be specified. As reference temperature the 

mean annual measured temperature can be used. Default value is 288.15 [K]. 

• Temperature gradient 

Here the Temperature gradient which is used for the Air density correction as 

described under Individual 3 should be given. Default value is −0.0065 [K/m]. 

Distance weighting 

If more than one climatology is present, the wind resource maps named "All" are combining 

the results of the single climatologies using as weighting factor the inverse of the distances 

between climatologies and grid node. In this way the results for the climatology closer to the 

node influences the result at the node more. This is applied, by default, using the simple 

invers of the distance weighting  𝑟0/𝑟 where 𝑟 is the distance and 𝑟0 the appropriate 

normalization factor. Modifying the distance weighting value changes the exponent that will 

be applied. Values higher than 1increase the weights of the closest climatologies. E.g. if the 

distance weighting is 2  then 𝑟0
2/𝑟2 is used to define the weighting, 3 will use 𝑟0

3/𝑟3 . The 

climatology weighting factor obtained from the inverse of the distance will be multiplied by the 

reliability to find the actual weighting factor of a climatology to a grid node. See also 

description of Reliability under Objects. 

2. Legend  

Legend minimum and maximum values 

Specification of the legend interval, if both minimum and maximum are set to zero the full 

range will be given. Default value is zero [-]. 

 

3. Export 

Export to ASCII format 

By enabling the Export to ASCII format option the wind resource map is exported as an 

ASCII file. The annual mean wind speed, TI, inflow angle, wind shear exponent, and TI 

15m/s is given. A link to the file will be provided in the report. The default value is False [-]. 

Export to WAsP format 

Exporting the wind resource map to the WAsP .rsf and .wrg formats. A link to the files will be 

provided in the report, likewise, plots of the Weibull scale and shape parameters. The default 

value is False [-]. 
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Export all 

Exporting the WAsP files weighted against all climatologies. This procedure is quite time and 

memory demanding and should only be activated if it is needed. The default value is True [-]. 

Type 

The WAsP files can be exported for different areas: the complete grid, the refinement area if 

there is refinement, and a user defined area. For the user defined area, the range in global 

coordinates and the horizontal resolution can be specified. 

X-range 

Here the X-range of the area that should be exported can be indicated referring to the global 

coordinate system. 

Y-range 

Here the Y-range of the area that should be exported can be indicated referring to the global 

coordinate system. 

Resolution 

Here the Resolution of the area that should be exported can be indicated. By default 

a Resolution of 100m100m is assumed. 

Export to Surfer format 

Exporting the wind resource map to .grd formats. A link to the files' folder will be provided in 

the report. The exported files are available in ''*project*\*layout*\energy\grd\'' and 

''*project*\windfield\grd\''. Activating WAsP Export, ''Complete Grid'' or ''Refinement area'', 

more maps are exported: Weibull-A and k and Sector frequency. The default value is False [-

]. 

 4. Cross-checking 

The purpose of the wind flow simulations in wind resource assessment is to extrapolate the 

wind measurements. These extrapolations consist in obtaining the wind speed at a target 

location T (typically a wind turbine) by multiplying the measured wind speed at a reference 

point R by a factor (Figure 11.1b). This factor is called the speed-up ratio SU, and it is 

calculated as 𝑆𝑈(𝑅, 𝑇) = 𝑢𝑇/𝑢𝑅where 𝑢𝑅 and 𝑢𝑇 are the modeled wind speeds at points 𝑅 

and 𝑇 (Figure 11.1a). 
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Figure 11. Example for the calculation of the speed-up ratio (a) and the measurement extrapolation 

(b). 

 

Therefore, the performance of a model is quantitatively evaluated by comparing the modeled 

SU with the measured one, between selected pairs of measurements. Specifically, the mean 

values of SU and wind speeds are utilized to calculate the so-called crosscheck prediction 

𝑋𝑃𝐸(𝑅, 𝑇) =
𝑆𝑈(𝑅,𝑇)⋅𝑢𝑀,𝑅−𝑢𝑀,𝑇

𝑢𝑀,𝑇
. It is possible to calculate one XPE per pair of measurement 

points. 

The cross-checking functionality now estimates the errors of the numerical model in 

predicting measurements on the basis of XPE values. Whenever multiple measurements 

exist, represented as climatologies with the given time history format .tws, a cross-checking 

can be performed. All possible climatology pair combinations are then cross-checked 

automatically, defining one climatology as the reference and the other climatologies as 

targets. In a project with for instance three climatologies all six combinations will be cross-

checked as shown in figure 12. 

 

Figure 12. Cross-checking combinations in a project with three climatologies. 

The cross-checking is based on concurrent time series. It calculates the ratios of the wind 

speeds (speed-ups) and ratios of the standard deviations for all concurrent time records of 

one reference and one target. These ratios are calculated in two different ways; filtered and 

unfiltered. The filtered way includes wind speeds inside the operational range of a typical 

wind turbine, the default range is from 3 to 25 (m/s). Whereas the unfiltered way includes all 

wind speeds except calm conditions when the wind speed is zero. 

https://windsim.com/library/championship/2022%20Winner/report_export/ModuleDescriptions/Climatology_data_format.html
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Hence two sets of errors are estimated based on filtered and unfiltered data. The errors 

obtained by filtering should be closer to the errors obtained from the numerical model for the 

operational range of wind speeds for a wind turbine. Results presented in the report tables 

are based on filtered data. In the underlying files linked in the report there is also unfiltered 

results. 

Wind Speed 

With this option it is possible to limit the range of wind speeds that should be used for cross-

checking. The wind speed range can be determined at the reference point or at the target 

point or for both. 

Wind speed ref 

By specifying a certain wind speed range, the cross-checking procedure filters for wind 

speeds at the reference point that are within this range. 

Wind speed target 

By specifying a certain wind speed range, the cross-checking procedure filters for wind 

speeds at the target point that are within this range. 

Wind Speed st. dev 

With this option it is possible to limit the range of the standard deviation of the wind speeds 

that should be used for cross-checking. The range of the standard deviations can be 

determined at the reference point or at the target point or for both. 

Wind Speed st. dev ref 

By specifying a certain range of standard deviation, the cross-checking procedure filters for 

the standard deviations at the reference point that are within this range, all others are 

neglected. 

Wind Speed st. dev target 

By specifying a certain range of standard deviation, the cross-checking procedure filters for 

the standard deviations at the target point that are within this range, all others are neglected. 
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Energy 

The annual energy production (AEP) 

The annual energy production, AEP is calculated for all visible Turbine objects. If several 

climatology objects are available the AEP based on each climatology is calculated 

separately. Any discrepancies between the AEP's based on different climatologies are easily 

accessible. A climatology is given by a time series, or its frequency distribution which 

presented graphically in the wind rose. Additionally a climatology is given by its Weibull 

distribution. The AEP is calculated for all representations. 

Properties 

1. Calculations 

Air density correction 

In general, every power curve is given for a specific air density. If the air density given in the 

power curve of the considered turbine is assumed to differ from the air density at the position 

of the turbine a correction can be applied with following approaches. By default No 

correction will be applied. 

No correction 

The given power curve is not corrected. If the density at the turbine position equals or is 

approximately equal to the density specified in the power curve this approach should give 

proper results, otherwise one of the following corrections should be chosen. 

Fixed value, Individual 1, Individual 2 & Individual 3 

See description page of Wind Resources . 

Method for density correction 

Two different correction methods can be applied to the power curve depending on the power 

control system of the WECS (EN 61400-12). 

Pitch-regulated WECS 

In the case of pitch-regulated wind turbines the power output of the WECS is calculated by 

entering in the original power curve with a corrected wind speed. The corrected wind speed 

is obtained by the wind speed times the fraction (air density AEP)/(air density power curve) at 

the power 1/3. 
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Stall-regulated WECS 

In the case of stall-regulated wind turbines the fraction (air density AEP)/(air density power 

curve) is used in the AEP calculations as a multiplication factor of the reference power 

curves. 

Sector interpolation 

See description page under Wind Resources . 

Wake effects 

See description page under Wind Resources . 

Height of reference production 

By default the energy production is calculated at the measurement mast position in the 

measurement height and in 80m above ground level. This Height of reference production can 

be changed to any value and additional heights can be added in terms of a semicolon 

separated list, i.e. 80;100. 

Rotor equivalent wind speed 

If the rotor equivalent wind speed (REWS) calculation is activated, the wind speed at turbine 

position is not only calculated at hub height, additional heights in the rotor area are taken into 

account. The total number of heights contributing to the REWS depends on the number of 

fractions defined under Number of fractions. To compute the rotor equivalent wind speed, the 

wind speeds of all contributing heights are weighted according to the surface fraction that 

belongs to each height, as shown in Figure 13. For example, if the number of fractions is 3, 

the REWS will be calculated as a weighted sum of the speeds at the hub height, hub 

height +2/3 radius of the turbine and hub height −2/3 radius of the turbine. The weighting 

depends on the surface portion of the circle belonging to each height (see Figure 1). The 

same logic is applied to 5,7 and 9 rotor fractions cases. 
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Figure 13. Definition sketch of rotor fractions for rotor equivalent wind speed calculation. 

 

 

Distance weighting 

See description page of Wind Resources . In the energy calculation the distance is 

calculated between climatology and turbine position at hub height. 

Manual weighting 

For the energy calculation weighted against all climatogies, the weighting of the results of the 

single climatologies is given manually in a table for each turbine. The values reported by 

default are obtained using the inverse of the distance with the exponent defined in 

the Distance weighting parameter and the Reliability parameter of the climatology 

(see Objects module). To weight a turbine only by a single climatology, modify the line of the 

turbine and set the values of that climatology to 1 and the values of all the other climatologies 

to 0. After modification save the file by pressing ok. Values between 0 and 1 will lead to 

manual weighting. A value of -1 in a line will reset to the default calculation for that turbine 

using the weighting factors obtained from the inverse of the distance multiplied by the 

reliability. 

 2. Export 

Export power history 

The visible climatologies of type time history (.tws) are transferred to the hubs of each visible 

turbine; the relative .tws files are placed in the object folder of the project. ASCII files 
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containing the electrical power output of each WECS for each record of the time history files 

are furthermore created and saved into the report folder. A link to the power history files will 

be provided in the report. 

Export weighted Power history 

All time histories transferred to the hub height of each visible turbine used to calculate power 

output (“powerhistory_clim…_wes_....dat”) are loaded and weighted with the inverse 

distance. By this procedure a weighted time series is obtained and associated ASCII files 

which contain the electrical power output are created. A link to the power history files will be 

provided in the report section called “powerhistory_clim_all_to_wecs_....dat/.csv”. 

Note: the time series of the whole layout, i.e. the time series of each climatology need to be 

consistent with each other. They must be of the same length, with the same time step as well 

as providing the same time period. 

 

 

 

Export rotor profiles 

An ASCII file with rotor profiles at all visible Turbine positions is produced. Data is extracted 

from the wind database in the corners of a square centred at the hub. A link to the file will be 

provided in the report. 

 

Figure 14. Definition sketch of rotor profiles. 
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The rotor profile file contains the same variables as the vertical profiles, see above. The 

variables are given at the hub as well as in the corners of a square centred at the hub, the 

extension of each side is equal to the rotor diameter as determined in the module Objects . 

The following syntax is used for the corners (compare to Figure 14): Upstream (U), 

Downstream (D), Right (R), Left (L), Top (T) and Bottom (B). The upstream plane of the cube 

is perpendicular to the incoming wind direction. The position in the vertical direction is 

referred to as: above sea level (asl), above ground level (agl) and referred to HUB (rth). 

The default value is False [-]. 

Export turbine assessment 

By activating the option Export turbine assessment important sectorwise parameters at the 

turbine positions are written into a file. The basic information that are included are the annual 

energy production (without and with wakes losses), the Weibull parameters and the wakes 

losses. In case the IEC classification is executed additional parameters are written as the 

representative turbulence intensity (Irep), the effective turbulence intensity (Ieff), the wind 

shear exponent and the inflow angle. 

Export vertical profiles 

An ASCII file with vertical profiles at all visible Turbine positions is produced. The profiles are 

extracted from the wind database from ground level up to the Height of reduced wind 

database specified in the Wind Fields module. A link to the file will be provided in the report. 

 

Figure 15. Definition sketch of vertical profiles, e.g. Speed_2D. Variable values are given in cell centres. 
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The vertical profile file contains the following variables: 

𝑢 - wind speed scalar in East-West direction [m/s] 

𝑣 - wind speed scalar in North-South direction [m/s] 

𝑤 - wind speed scala in vertical direction [m/s] 

Speed_2D - wind speed scalar in horizontal plane √𝑢2 + 𝑣2 [m/s] 

Inflow - angle with respect to the horizontal, arctan(𝑤/√𝑢2 + 𝑣2) , [deg] 

Shear - derivate of Speed_2D with respect to vertical direction  ΔSpeed_2D/Δ𝑧 [1/s], where 

ΔSpeed_2D = Speed_2Dk+1 − Speed_2Dk-1 and Δ𝑧 = 𝑧𝑘+1 − 𝑧𝑘−1 

Shear_low- derivate of Speed_2D with respect to vertical direction, ΔSpeed_2D/Δ𝑧 [1/s], where 

ΔSpeed_2D = Speed_2Dk − Speed_2Dk-1 and Δ𝑧 = 𝑧𝑘 − 𝑧𝑘−1 

Shear_high - derivate of Speed_2D with respect to vertical direction, ΔSpeed_2D/Δ𝑧 [1/

s], where ΔSpeed_2D = Speed_2Dk+1 − Speed_2Dk and Δ𝑧 = 𝑧𝑘+1 − 𝑧𝑘 

KE - turbulent kinetic energy [m2/s2] 

TI - turbulent intensity assuming isotropic KE, 100 ⋅ √4 𝐾𝐸/3/√𝑢2 + 𝑣2 [\%] 

𝛼 - wind shear power exponent 𝛼𝑘 = (𝛼𝑘−1 + 𝛼𝑘+1)/2 [-] with  

𝛼𝑘−1 = ln(Speed_2Dk-1/Speed_2Dk) / ln(𝑧𝑘−1/𝑧𝑘) 

𝛼𝑘+1 = ln(Speed_2Dk+1/Speed_2Dk) / ln(𝑧𝑘+1/𝑧𝑘) 

The default value is False [-]. 

3. IEC Classification 

In this option of the Energy module the suitable IEC class for each turbine of the current 

layout is calculated, as described in the standards IEC 61400-1 [2,3,4]. The IEC classification 

of the turbines is performed for both the 2nd edition [2] and 3rd edition [3] of the standards, 

accounting for the amendment 1 (2010) [4] of the 3rd edition. Each .tws is transferred to each 

hub position, and then the parameters Vref, Iref (mean value and standard deviation) are 

computed for the transferred .tws. The reference velocity, an extreme wind (10 min average) 

with a recurrence period of 50 years, is computed by a Gumbel fitting the peaks of 

transferred wind speeds. The Gumbel fit can be performed in different ways depending on 

the way to detect peaks and the fit method applied: Annual maxima with Harris '96 method 

[5], Independent storms with Harris '99 method [6] and Annual maxima with maximum 

likelihood method. The methods of fitting are described in details in the relative publications, 

Annal maxima peaks detection uses one value per year, the maximum speed measure in the 

year, at least two year of data are needed to enable the fit, but is suggested to have longer 

time series to make the fit more meaningful. Independent storms method defines the storms 

as periods exceeding the Storms threshold (m/s) and peaks as their maximum values. To 

ensure that the peaks are not part of the same storm event the Storms window length (h) 
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value can be tuned: two peaks are considered part of separate storm event if the distance in 

time is higher than the windows length, if not the higher between the two is used in peaks fit. 

In case the time stepping of the reference time series (.tws) is not 10 minutes there will be 

need to change the Gust factor accordingly. For the 2nd edition the IEC class is determined 

also according to the site annual average wind speed Vave. For some sites the restriction 

over the Vave is more severe than the one on the extreme wind speeds. The 3rd edition 

substituted the verification over the average wind speed with a more detailed verification of 

the site probability density function (pdf) over the turbine design pdf, which is a Rayleigh 

distribution. The check of the site pdf against the design pdf is not present in WindSim as 

output of the IEC classification, though it can be carried out analyzing the site through the 

WAT export or the turbines_assessment files. The Iref is given as expected value of the 

turbulence intensity for the 15 m/s bin, its standard deviation is also computed for the same 

samples. In the case of classification of wind turbines according to the second edition of the 

standards [2] a characteristic turbulent intensity is required (84th percentile, mean plus the 

standard deviation for a normal distribution). For the 3rd edition, as amended in the 2010, the 

turbulence class is instead determined by veryfing equation (35) of [4] in the range Wind 

speeds range Ieff. All values of Ieff are reported in the energy_IEC_classification.log file 

which is linked in the report of the "Energy.html" target="main" class="module"> Energy 

module. In the case of classification according to the third edition, it is verified that the 

standard deviation of the longitudinal component from the normal turbulence model 𝜎1 of the 

wind velocity at hub height is greater or equal to the estimated 90th percentile of the effective 

turbulence standard deviation (accounting for both ambient and wake turbulence) 

 𝜎1(𝑉hub) ≥ 𝐼eff(𝑉hub) ⋅ 𝑉hub 

where 

𝜎1 - standard deviation of the longitudinal component of the wind velocity, 

𝑉hub- wind speed at the hub height, 

𝐼eff - effective turbulence intensity. 

The verification is performed between for 𝑉hub ranging from 60% of the rated wind speed 𝑉𝑟 

and the cut-out wind speed 𝑉out. In the case rated and cut-out wind velocity are not specified 

in the power curve (.pws) file, the verification will be carried out automatically for 𝑉hub varying 

in the range 7−25 m/s if a user defined wind speed range is not given. 

The effective turbulence 𝐼eff is defined in the IEC standards as weighted average of 

turbulence intensity to the power of m, being m the Wöhler (SN-curve) exponent. For the IEC 

classification m is by default equal to 10, number valid to verify the glass fiber of the blades, 

the most fragile component of the wind turbine. The effective turbulence is therefore that 

turbulence intensity that would produce fatigue damage after the same number of cycles of a 

failure caused by the actual turbulence wind rose. 
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𝐼eff = [∫ 𝑝(𝜃|𝑉hub) 𝐼𝑚(𝜃|𝑉hub) 𝑑𝜃]
1/𝑚

 

here 

𝑚 - Wöhler exponent, 

𝜃 - wind direction, 

𝑝 - frequency of occurrence, 

𝐼 - representative value (90th percentile) of the turbulent intensity of the wind, 

𝑉hub  - wind velocity at the hub height. 

The turbulence intensity 𝐼 accounts for the presence of the neighboring turbines with the 

version of the Frandsen model as proposed in the Annex D of the last standards amendment 

[4]. 

The integral defining 𝐼eff is therefore discretized in a set of wind directional sectors. Using the 

subscript s for sector-wise properties, NS number of directional sectors: 

𝐼eff ≃ [∑ 𝑝𝑆(𝑉hub)𝐼𝑠
𝑚  (𝑉hub)]

1/𝑚

 

or the general sector 𝑠 Is is the representative value of the turbulence intensity, accounting 

for wake induced turbulence by 𝑁𝑠 neighboring (𝑑𝑖 < 10) turbines in the sector s. 

𝐼𝑠 = 𝜎eff,𝑠(𝜃𝑠, 𝑉hub)/𝑉hub 

 

𝜎eff,𝑠(𝜃𝑠, 𝑉hub) = [(1 − 𝑁𝑠  𝑝𝑤𝑠) 𝜎𝑟,𝑠
𝑚 (𝜃𝑠, 𝑉hub) + 𝑝𝑤𝑠 ∑ 𝜎𝑇,𝑠

𝑚 (𝜃𝑠, 𝑉hub)]
1/𝑚

 

𝑁𝑠 - neighboring turbines within sector s, 

𝑝𝑤𝑠 - probability to be under wake for a given sector, 

𝜎𝑟,𝑠- representative value of ambient turbulence intensity for sector s, 

𝜎𝑇,𝑠- representative value of turbulence intensity in wake condition. 

The turbulence intensity under wake condition is modeled with the following expression 

𝜎𝑇,𝑠(𝑑𝑖) = √
𝑉hub2

(1.5 + 0.8 𝑑𝑖/√𝐶𝑇)
2 + 𝜎𝑟,𝑠

2 (𝜃𝑠, 𝑉hub) 

 

where 

𝐶𝑇 - thrust coefficient of ii-th wind turbine generating the wake, 

𝑑𝑖 - distance (in rotor diameters) to the 𝑖-th wind turbine. 

Bin width 

Width of the velocity bin centered at 15 m/s used to compute mean and standard deviation of 

turbulence intensity. 

Gust factor 
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In the case the .tws file does not contain records averaged over 10 minutes there will be the 

need to adjust the Gust factor. In case of a .tws with stepping longer than 10 minutes, e.g. a 

hour, the Gust factor is the averaged ratio of the maximum 10 minutes peaks within the 

recording period and the mean wind speed in the same time; so a number bigger than unity. 

The Gust factor will multiply each yearly peak at the turbine location before fitting with a 

Gumbel distribution. 

Wöhler coefficient 

The Wöhler coefficient is the exponent m appearing in the definition of the effective 

turbulence Ieff. It is specific for the material used to build the component that will be verified 

to fatigue loads. In the case of a complex structure as a wind turbine it has be chosen the 

maximum coefficient between all components. A coefficient of 10, slightly conservative, is 

meant for the glass-fibers, generally present in the composite materials of the blades. 

 

Ieff filter 

A filter is set, given by the minimum number of samples needed to account for a sector in the 

Ieff calculation. 

Wind speeds range Ieff 

According to the IEC standards [3,4] the amended equation (35) in [4] has to be verified 

ranging from 60% of the rated wind speed (Vr) and the cut-out wind speed (Vout) of the 

turbine. If the properties of the turbine are unknown [4] recommends to verify in the range of 

wind speeds 0.2 Vref-0.4 Vref. When the Wind speeds range Ieff is set to its default value 

"According to IEC standards" the Ieff will be verified in the range 0.6 Vr-Vout; though, if 

turbine properties are unknown, the check will be performed between 7 and 25 m/s. 

Alternative to the default value is to set a user defined wind speed range. 

WAT Export 

Enabling this option allows to export a set of files to the report\WAT folder that can be later 

imported in Windfarm Assessment Tool (WAT), a free software by Risø and DTU Wind 

Energy. A basic WAT file (.txt) will be exported, together with turbulence files (.txt), power 

characteristics (.wtg) and a terrain file (.grd). Turbulence files are obtained by the transferred 

.tws at each hub position. Power characteristics in .wtg format are converted from the .pws 

files loaded in the Objects module while the digital terrain model (DTM) in .grd format is 

converted from the .gws file loaded in the current WindSim project. 

Excel Export 
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The ambient and effective turbulence is plotted against the IEC curves for each turbine for 

each sector and wind speed bin. 

Site Compliance Export 

All information which is needed for a site compliance study is gathered in one file. 

Matrix table Export 

The Matrix provides sector-wise binned split of turbine energy production, energy including 

wake effect, turbulence and speed frequencies. The Matrixes enable to analyze special 

cases like directional curtailment, sector management systems and more. Tab separate 

format is easy to load in other software and postprocess. 

AEP and IEC report Export 

The AEP and IEC results are a collection of information, in a tab separated text format, 

related to Annual energy production and IEC turbine class suitability analysis, following IEC 

61400-1 ed. 4 (2019) standards [7]. 
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WindSim Accelerator 

About WindSim Accelerator 

 

WindSim Accelerator is the cloud-native complement to WindSim Desktop, offering on-

demand, high-performance computing for micrositing workflows. By leveraging scalable 

cloud resources, Accelerator enables rapid execution of the Preprocessing and Wind Field 

modules within the browser, while integrating with WindSim Desktop for the remaining 

modules.  

Purpose and Scope  

The primary goal of WindSim Accelerator is to optimize the placement and performance of 

wind turbines over complex terrain (micrositing) through numerical wind-field simulations. 

Accelerator focuses on two core operations:  

1. Preprocessing: Preparation and tiling of digital elevation and roughness data for 

simulation.  

2. Wind Field Calculation: High-resolution CFD-based wind-flow modeling across the 

site.  

Remaining steps in the design chain—including object placement, climatology coupling, and 

energy assessment—continue to be executed in WindSim Desktop, preserving the familiar 

modular workflow. The cloud architecture unlocks higher-fidelity simulations by distributing 

the RANS solver across multiple compute nodes, enabling:  

• Finer Mesh Resolutions: More cells per cubic meter for detailed topographic 

features.  

• Advanced Solver Strategies: Hybrid parallelization and dynamic load balancing for 

large-scale domains.  

 

Modular Architecture  

WindSim Accelerator mirrors the modular design of WindSim Desktop, currently comprising 

three modules:  

1. Map Module: Interactive visualization and configuration of terrain elevation and 

roughness datasets.  

2. Model Module: Set-up of computational meshes and solver parameters based on 

user-defined settings.  

3. Wind Fields Module: Distributed execution of the RANS-based CFD solver for wind-

flow prediction, with real-time progress tracking.  
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Continuous Evolution  

WindSim Accelerator is under active development, with new features and optimizations 

released regularly. Upcoming enhancements include expanded postprocessing options, 

which finally will replace the need for WindSim desktop as a postprocessing tool.  

 

Map  

Area of Interest 

The first step in setting up a flow field simulation is extracting topography and roughness of 

the target area. In Accelerator, this is done using the Map module, which utilizes the World 

Elevation Terrain service provided by ESRI. This dynamic terrain service supplies numerical 

values representing ground surface heights based on a digital terrain model (DTM) from 

multiple data sources. Heights are referenced to sea level (orthometric height = 0), and water 

bodies above sea level have approximated nominal water heights. 

Specifying the coordinates 

There are two methods to define the area of interest: 

Using the Box Selector: 

• Click on the desired location to set the centre coordinates of the simulation 

domain. 

• The box selector will automatically generate a rectangular refinement zone 

with specified vertical and horizontal dimensions. 

Using Latitude and Longitude Coordinates: 

• Manually set latitude and longitude markers to define the points of interest. 

• The system will generate a rectangular refinement area based on the 

minimum and maximum latitude/longitude values.  

Refinement and Buffer Zones 

The refinement zone represents the area where the simulation results are expected to be 

most accurate. When using markers, the area is extended 2 km beyond the markers (such 

as turbines or meteorological masts) to better capture ground effects. 

When using the box selector, it is recommended to extend the refinement area to ensure 

high resolution near critical points, such as turbines. 
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The buffer zone reduces the impact of boundary conditions. At the inlet, where the wind 

enters, the simulation assumes a logarithmic wind profile based on surface roughness. As 

the wind flows over the buffer zone, it develops a more realistic profile before reaching the 

refinement area, reducing boundary effects. The buffer zone is by default set to 10000 m 

beyond the refinement area. It should be ensured that the edges of the buffer zone do not 

contain significant features (e.g., large cliffs), as they can create unwanted simulation effects 

that extend into the refinement area. 

Checking Elevation Map Resolution 

To check the resolution of the elevation map at a given location: 

• Use the interactive map. 

• Scroll to the area of interest. 

• Right-click on the map to view the data source and resolution used at that site. 

Setting Up Surface Roughness 

Two roughness datasets are available , The Corine Land Cover 2018 (CLC2018) Roughness 

(Europe) and Sentinel-2 Roughness (Global). CLC2018 is one of the datasets produced 

within the frame of the Corine Land Cover programme referring to land cover / land use 

status of year 2018. Sentinel-2 is a 10-meter resolution land cover time series of the world, 

produced by Impact Observatory, Microsoft and Esri.  

 

Steps to Configure Roughness: 

1. Enable the roughness layer in the right-hand toolbar to visualize roughness 

categories. 

2. Adjust roughness category values if needed. 

3. Once the roughness setup is satisfactory, click "Extract Terrain". 

4. After terrain extraction is complete, proceed to the Model tab to continue the 
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Model  

Numerical 3D Model 

After extracting terrain data using the Map module, you can proceed to create a discretized 

model of the simulation domain. Click on the Model tab on the left-hand side to get started.                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                            

https://www.arcgis.com/apps/mapviewer/index.html?layers=3af669838f594b378f90c10f98e46a7f
https://image.discomap.eea.europa.eu/arcgis/rest/services/Corine/CLC2018_WM/MapServer
https://ic.imagery1.arcgis.com/arcgis/rest/services/Sentinel2_10m_LandCover/ImageServer
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Converting to Grid File 

Once the elevation and roughness data are extracted: 

1. The images are converted to the grid.gws file format. 

2. The full 4000x4000 resolution is retained to avoid interpolation losses. 

3. The grid.gws file is used to create a 3D computational grid following the terrain. 

Settings 

Several parameters can be adjusted when generating the 3D model: 

Height Above Terrain: 

• Defines the height (in meters) of the model above the highest terrain point. 

• Higher terrain features require a greater model height. 

• An automatic option is available for optimal height selection. 

Resolution of Horizontal Cells 

The horizontal resolution of our model is based on the maximum number of cells, or by 

setting the horizontal resolution. 

Cells maintain constant size in the refinement area, with gradual size increase in the buffer 

zone. 

Height Distribution Factor 

• The model assumes geometric vertical expansion with this factor. 

Number of Vertical Cells 

• Specifies the number of cells along the z-axis. 

• Higher resolution is required near the ground, while lower resolution is sufficient in 

upper layers. 

• Geometrical expansion controls vertical cell sizes 

For more detailed description of these features, see WindSim 12 Desktop numerical 

model.  

Forest Modelling 

Configuring Forest Representation 

If a forest is present in your selected area, you can enable forest modelling to refine your 

simulation. 
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1. Enable the Forest Model: 

o Open the Forest widget. 

o Click Add Forest. 

2. Set Forest Parameters: 

o Roughness Height: The roughness value representing the forest. 

o Height: The actual forest height. 

o Resistive Force C2: The resistive force proportional to velocity squared. 

o Z direction cell count: The number of vertical cells representing the forest. 

o Turbulence Sources: Defines whether the forest affects turbulence. 

o Enter forest values and verify roughness settings. 

o Click Create 3D Model. 

o Check the Forest box in the result pane to validate placement. 

Vertical Grid and Forest Interaction 

• The bottom layer of cells is controlled by the forest model. 

• Above the forest, geometrical expansion determines cell distribution. 

• The grid (z) view provides an exact distribution. 

Multiple Forests 

• If multiple forests exist, cell heights must align. 

o Example: 

▪ Forest 1: 10m height (2 cells of 5m each) 

▪ Forest 2: 20m height (4 cells of 5m each) 

▪ Both forests align at the bottom 2 cells. 

A closer description of the forest model can be found in WindSim 12 Desktop forest model. 

Investigating the Model 

To verify the model before running the wind field simulations, we should investigate the 

different layers now created as part of the model, which include: 

Terrain Layers 

• Elevation 
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• Roughness 

• Roughness Logarithmic 

• Inclination 

• Second Order Derivative (Curve) 

• Delta Elevation 

3D Model Layers 

• Grid (XY) 

• Grid (Z) 

• Open Area 

Modify settings if necessary and regenerate the 3D model before proceeding to the 

Windfields tab. 

Preprocessing in WindSim desktop 

Alternatively, a customer may want to use their own data for creating a grid file. The pre-

processing then needs to take place in beforehand using WindSim Desktop (see digital 

terrain conversion). A pre-processed project, ready for simulations, can thereafter be 

uploaded to WindSim Accelerator. The workflow is outlined in the steps below.  

Start WindSim desktop 

1. Create a new or open existing project in WindSim desktop. 

2. Run the Terrain module to establish the computational model to generate the wind 

database successively.  

3. When the Terrain module has been completed, go to the Wind Fields module to 

specify the Properties for wind fields calculations, or set them directly in the 

WindFields module in WindSim Accelerator. 

4. Save the project, File -> Save.  

Upload project in WindSim Accelerator 

When you log in to WindSim Accelerator, you are directed to the Dashboard and the Project 

list. The steps below show how to upload the project you created in 

WindSim desktop.    

 

1. Select Upload project 
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2. Choose the folder where your project and belonging files are located. The new project 

is visible and accessible to everyone in your organization. You can change it to 

private in project settings. 

 

 

 

3. Upload status is displaying progress.  

 

 

 

4. Inspect the wind fields input.  

 

The input parameters can be modified if needed. You can correct potential mistakes or adjust 

them to changing needs. You can re-run the simulation on a single project multiple times or 

duplicate it on the project list and run it in parallel. If you want to run a simulation on an 

existing project (use the previous results), ensure the checkbox “Use the previous run as 

input” is selected. 
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Wind Fields  

Prerequisites 

An advanced project in Accelerator where the Map and Model modules has been 

successfully run, or an uploaded WindSim 12 project in which the Terrain is already 

completed. 

Settings 

• Boundary and initial conditions 

o Do nesting: Not implemented on Accelerator yet 

o Sector input type: Select which sector you want to run in the simulation 

o Height of boundary layer 

o Speed above boundary layer  

o Use previous run as input: Continues a previous run, this can be enabled 

when a run did not yet reach a satisfactorily convergence but looks promising. 

o Boundary condition at top 

▪ Fixed pressure: Suitable on complex terrain 

▪ No-friction wall: Suitable for flat terrain 

▪ Diffusive link (moving fixed pressure): Like fixed pressure case but 

imposing a constant speed at the top. The imposition of a constant 

speed enables us to lower the height of the model and use less cells 

vertically 

• Physical models 

o Turbulence model: 

▪ Standard k-epsilon 

▪ Modified 

▪ k-epsilon with YAP correction 

▪ RNG k-epsilon 

• Calculation parameters 

o Solvers: 



 

© 2025 WindSim | DUPLICATION OF THIS DOCUMENT IS PROHIBITED WITHOUT PRIOR PERMISSION 

58 WindSim Accelerator 

▪ GCV (General Collocated-Velocity) 

▪ Parallel GCV (A parallelized version of the GCV) 

▪ Parallel GCV + AMG (Algebraic MultiGrid, uses the AMG to solve the 

pressure equation) 

o Convergence settings: 

▪ Use manual definition for specifying 

▪ Exploratory for initial investigation of a site 

▪ Accurate for recommended convergence rate 

• Convergence monitoring: Sets the point of the map where the spot value plots are 

located. The monitored spot should be set in an area where the conditions are of 

interest. 

• Output 

o Height of reduced wind database: For further postprocessing of the data only 

the lower layer of the air column is of interest. Here you can specify the 

volume. Having a lower height will speed up postprocessing. 

o XY reduced wind database: Only the area inside the refinement area is of 

sufficient quality and of interest for processing, this option enables a smaller 

database of the windfields only encompassing that area. 

For closer description of flow equations, settings and solution methods please refer to 

WindSim 12 Desktop Wind Fields.  

Stability in Accelerator 

Accelerator can run simulation with preserved temperature settings that you set in the 

desktop version. It is possible to do stability simulation on Accelerator. Unfortunately, the 

Web GUI does not show the temperature settings yet, but the settings you set in the Desktop 

will be preserved after you upload the project to Accelerator. In a future version we will show 

the temperature settings, so you can change them in the Web GUI as well. The stability 

option, only using Monin-Obukhov length, is now added to Accelerator and can be selected 

in Wind Fields. 

Running Wind Fields 

When selecting Run Wind Fields, the wind field simulations are submitted to the cloud, and 

simulations for each sector run independently on separate servers. 

The user can follow the progress through the interface, and in the Job status menu, you can 

https://www.cham.co.uk/phoenics/d_polis/d_enc/enc_gcv.htm
https://www.cham.co.uk/phoenics/d_polis/d_enc/solvers.htm
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• Follow progress of each sector job 

• Refresh job status manually 

• Stop all jobs 

• Cancel all jobs 

• Stop / cancel individual jobs, for each sector 

• Check results for each sector after completion 

o Field value 

o Spot value 

o Residual values 

o Residual values log 

Simulation time and credits approximation 

The total wall-clock time for a simulation can be estimated using the relationship 

𝑇𝑠𝑖𝑚 = 𝑁𝑖𝑡𝑒𝑟 × 𝑁𝑐𝑒𝑙𝑙𝑠 (𝑚𝑖𝑙𝑙𝑖𝑜𝑛) × 𝐹𝑒𝑚𝑝 

where 𝑁𝑖𝑡𝑒𝑟  is the number of solver iterations, 𝑁𝑐𝑒𝑙𝑙𝑠  the mesh size in millions of cells, and 

𝐹𝑒𝑚𝑝 an empirical factor that captures the combined performance of the hardware, solver 

algorithm and parallel efficiency. 

The number of iterations depends on the complexity of the site. For a medium-complexity 

case, a good rule of thumb is roughly 100 iterations per million cells (𝑁𝑖𝑡𝑒𝑟 ≈ 100 ×

𝑁𝑐𝑒𝑙𝑙𝑠 (𝑚𝑖𝑙𝑙𝑖𝑜𝑛)). Highly complex sites may require significantly more iterations, and simpler 

problems may converge in fewer than 100 iterations per million cells. The chosen 

convergence criteria (residual tolerances) directly influence both iteration count and solution 

accuracy: tighter tolerances reduce numerical error but can multiply iteration requirements, 

whereas looser criteria speed up runs at the expense of potential under-resolution or 

instability. 

The table below summarizes the approximate credit requirements for different project sizes 

and shows how many projects each Accelerator plan supports.  
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Postprocess results in WindSim desktop 

• When the simulations are completed or stopped manually by the user, the results 

filed are stored in a project.zip file. The project.zip file can be downloaded by 

selecting Download project. 

• Unzip project.zip to the project folder on your local machine/server. 

• Run the script RunReports.bat script to generate results. The script is located in the 

downloaded project folder. The script will generate results for Spot values, Residual 

values and Residual values log and display these in WindSim desktop when you 

open the project file. 

• As in WindSim desktop, you can restart a simulation from the end state if it does not 

converge. Be aware that the existing data will be overwritten unless you duplicate 

your project. 

Best Practices and Recommended Settings 

This section provides best practices and recommended settings for running wind simulations 

efficiently and accurately. These guidelines are based on experience and testing to help 

users configure simulations for optimal performance. 

Default Settings: Are They Suitable for All Sites? 

Default settings can work well for many sites, but they might not be the best fit for every 

location. Users should evaluate their site characteristics and make necessary adjustments 

using available configuration options such as: 

• Forest Model: Used when the simulation includes forested areas. 

• Top Boundary Conditions: Selection depends on terrain complexity. 

• Turbulence Models: Different models are available depending on flow characteristics. 

• Grid Size: Determined based on project size and computational resources. 

When Should You Start Tweaking Models? 

There are several indicators that a model may need adjustments: 

• Non-Convergence: If the model does not converge, factors such as boundary 

conditions and locations, grid resolution, and terrain complexity may need revision.  
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• Mismatch in Vertical Profiles: If vertical profiles do not align with observations, 

consider adjusting atmospheric stability settings. 

• Keep in mind that well behaving solutions can be physically wrong, due to choices or 

simplification of modelling. It is therefore essential to interpret the results in a physical 

context and validate them against observational data.  

Top Boundary Conditions: Understanding and 

Selection 

Selecting the appropriate top boundary condition for accurate simulations: 

• Fixed Pressure: Recommended for complex terrain as it maintains realistic pressure 

gradients. 

• No-Friction-Wall: Suitable for flat terrain, ensuring that momentum remains 

consistent. 

• Diffusive Link (Moving Fixed Pressure): Used for simple terrain while maintaining a 

constant wind speed at the top boundary. 

Turbulence Models: Selection Guidelines 

Turbulence models impact the accuracy of flow predictions. The following options are 

available: 

• Standard k-ε Model: Commonly used but not ideal for complex terrain due to 

excessive vertical mixing. 

• Modified k-ε Model: Adjusted for atmospheric conditions, offering better performance 

in complex terrains. 

• RNG k-ε Model: Best suited for cases with recirculation and complex flows, providing 

improved convergence. 

• YAP Correction: Can improve performance in separation zones and is generally 

recommended. 

When to Use Smoothing 

Smoothing should generally be avoided unless necessary due to divergence in the Wind 

Fields module. Consider using smoothing if: 

 

• Grid Skewing Causes High-Speed Anomalies: A smoothing factor around 0.1 should 

be the initial attempt. 
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• Persistent Divergence Issues: Gradually lower the second-order derivative threshold 

and use the "Smoothing Radius" to avoid excessive smoothing near wind farm 

locations. 

Smoothing is currently only available in the desktop version.  

Grid Size: Considerations and Recommendations 

Grid resolution impacts computational efficiency and accuracy. Considerations include: 

• Desktop Users: Hardware resources (CPU, memory) should be evaluated. 

• Typical Resolution: 10 - 50 m resolution is standard. 

• Complex Terrain: Higher resolution is preferred. 

• Vertical Layers: 25-30 layers are sufficient for flat terrain but should be increased for 

finer horizontal resolutions. 

• Bottom Layers: The lowest three layers should have similar thickness for numerical 

stability. 

Solvers: Selection Based on Project Needs 

Choosing the right solver depends on the project scale and computational resources: 

• GCV Solver: Preferred for its strong convergence behaviour. 

• Parallel GCV-AMG Solver: Best for large projects exceeding 4 million cells as it 

speeds up computations. 

Stability: Key Considerations 

Understanding atmospheric stability conditions is essential for accurate wind simulations: 

• Observation Data Analysis: Determine whether stable conditions dominate the site. 

• Monin-Obukhov Length (MOL): Should be greater than 50 for valid simulations. 

• Negative MOL Values: Should be avoided as they lead to non-physical results. 

Additional Considerations 

Extensions of the Simulation Area 

• The area should be large enough to include key terrain features influencing wind flow. 

• Ideally, boarders should be placed along ridges rather than valleys to avoid artificial 

speed-up effects. 
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• If terrain cutting leads to unwanted effects, terrain smoothing can help minimize 

errors (only desktop). 

Cell Aspect Ratio 

• Divergence issues may arise if the cell length/cell height ratio exceeds 10. 

• Keeping cells as close to a cubic shape as possible enhances stability. 

Maximum Number of Cells (only desktop) 

• 1.2 GB RAM is typically required per 1 million cells. 

• Large simulations should ensure adequate virtual memory allocation to prevent 

slowdowns. 

Vertical Gridding 

• At least 6-8 cells should be placed in the first 100 m above ground for accurate flow 

representation. 

• The first cell should be at least twice the roughness element height. 

Refinement Area Size 

• Keep rotor diameters at a reasonable distance from the refinement edges. 

• Ensure grid stretching is not excessive near the boundaries. 

Forest Modelling 

• Used for forested areas larger than 1 km in diameter. 

• Avoid forested areas at the inlet as they can create unphysical effects propagating in 

the domain.  

• Must be configured based on the site’s forest characteristics. 

• Ensure appropriate wind profiles within forested regions to avoid divergence. 

Nesting vs. Refinement (only desktop) 

• Refinement is preferred over nesting, which can restrict flow conditions. 

• If nesting is necessary, the outer coarse model should have a resolution no coarser 

than 100-200 m. 

• The fine model should maintain a resolution of 10-30 m within the refinement area. 

Postprocessing Considerations 

Wake Modeling  

• The Jensen model performs best, especially with the sum of squares method for 

multiple wakes. 
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• For large turbine arrays, averaging results from different wake calculation methods 

can improve accuracy. 

Cross-Checking and Quality Improvement 

• Cross-checking should only be performed for time series covering the same period 

without long-term corrections. 

• Large errors may indicate roughness inconsistencies, non-neutral atmospheric 

effects, or thermal/mountain wind systems. 

• Compare LIDAR measurements with simulations to refine model accuracy. 

Following these best practices ensures a more accurate and stable wind simulation process. 

Users are encouraged to experiment within these guidelines and reach out to WindSim if 

further assistance is needed. 
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